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Microsoft Excel Tutorials

Excel Spreadsheets

In this section of the course, you're going to learn what spreadsheets are, and what they can do. You'll get
a first glimpse of the Microsoft Excel software, and how it works. You'll also learn about cell coordinates,
rows and columns, and how to enter data into a cell. So, let's make a start.

What is a Spreadsheet?

A spreadsheet is a piece of software for handling and manipulating numbers. You can write numbers down
on a piece of paper and add them up. Like this:

23
12
10
45 =

But that's not a spreadsheet. However, if you bought Microsoft Excel and entered the same numbers into
the software, you'd have a spreadsheet. The best part about a spreadsheet is - you don't have to do any
adding up yourself! The programme will add the numbers up for you.

A spreadsheet doesn't only add up, of course. It can do a whole lot more besides simple arithmetic. It can
handle financial calculations, statistical information, and do complex trigonometry. And it can make a pretty
graph for you.

At it's heart, though, a spreadsheet is just a glorified calculator. The main point of using a spreadsheet is do
some number crunching. The software will puzzle out the answers to sums for you, and save you a lot of
time and effort carrying sevens and trying to remember what eight multiplied by six is.

Why do | need a Spreadsheet?

There are many reasons why you might need a spreadsheet. Here are few different scenarios:
Scenario 1 - Personal Investments

You have bought shares in a few different companies and want to keep track of how well, or badly, they are
doing. You could enter these values in a spreadsheet:

MyShare: Sharel
Price Paid: 0.25
Number Held: 1000
Total Cost: £250
Value Now: 0.35
Worth Now: £350
Profit/Loss: +£100

The spreadsheet would do all the sums for you. All you have to do is enter the correct formulas. In the
spreadsheet above, if we changed the number in the "Value Now" box, the "Worth Now" box and the
"Profit/Loss" box will automatically be updated. That way you could see at a glance how well your shares
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are doing.

Scenario 2 - Personal Finances

We only have a limited amount of money coming into the house each month. The problem is, that money
seems to be disappearing pretty fast. If would be nice if we could keep track of where it's all going. A
spreadsheet could help us. We could enter the data like this:

Monthly Income: £1500

Gas: 25
Electricity: 20
Phone: 35

HP: 250

Food: 350
Mortgage: 425
Car: 130

Total: £1235
Leftover: £265

Of course, we could do all that on a piece of paper. But entering the data into a spreadsheet gives us better
control. We could change one value, that massive food bill, and see how much we had left over if we didn't
spend so much money on food. Once the formulas are entered, the other figures would be updated
automatically.

So there we have two simple scenarios where a spreadsheet might come in handy. Of course, they can be
used, and often are, in a business situation. If you want to keep track of things like stock and profit margins,
then spreadsheets are very useful indeed. In fact, spreadsheets are useful in a wide range of situations,
both business and non-business.

We'll now move on, and get our first glimpse of Microsoft Excel.
Launch and Explore Excel -->
<--Back to the Excel Contents Page
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Launching and Exploring Excel

To launch Microsoft Excel, do the following:

Click on the Start button in the bottom left hand corner of your computer screen
A menu pops up

Move your mouse up to Programs

A sub menu appears

Move your mouse to Microsoft Excel

When Excel is highlighted, click once with your left mouse button

ocoobkhwnE

When you have clicked on Microsoft Excel, the software will load. When it is finished you will be looking at
the main Excel screen. It will look like the picture on the next page. If you've never seen spreadsheet
software, it can seem quite daunting at first. But don't worry: we'll break it down.

The main Excel screen then looks like this one:

Excel Main Screen (Opens in new window 67KB)

It is a fairly daunting piece of software, at first glance. To break it down, let's start with all those numbers
and letters.

Grid Coordinates

Right across the top of the spreadsheet you'll notice that there are some letters, A to L in the picture
above. The letters are the columns. If you click on any of the letters with your left mouse button, you'll
highlight an entire column. In the picture below, the letter B has been clicked on, thereby highlighting this
entire column.

L =N == N Gl =l 5, I RN LN

—
=

You can't change the letters. If you wanted to call column B "Column Two", for example, this would not be
possible. You're stuck with the letters.

Running right down the left hand side of the spreadsheet are numbers. The numbers are the Rows. Click
on any of the numbers to highlight an entire row. In the image below, the number 5 has been clicked on,
thereby highlighting the entire Row.
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In a spreadsheet, you combine a Column letter with a Row number. This gives you an individual Cell in the
spreadsheet. For example, the B column plus Row 5 will give you an individual Cell of B5. Likewise, the D
Column plus Row 6 will give you an individual Cell of D6.

To see this in action, click on any of the cells in the spreadsheet. In the two pictures below, the picture on
the left shows a darker border around cell Al; in the picture on the right, the darker border is now around
cell C3.

o |l | | —
H

o | L0 | B | e

Notice two things: first that your mouse pointers turns into a white cross when it moves around the
spreadsheet; second that the coordinates of the cell are displayed at the top left.

When we clicked inside cell C3 with the left mouse button we highlighted that cell. When we highlight a cell,
it has the thicker black border around it. This means that it is the Active cell. The coordinates of the Active
cell are displayed in the top left - in the Name Box.

When you enter text or numbers into a cell, you first have to make it the Active cell. In other words, you
have to click on it to highlight the cell. (Another way to move around the cells in a spreadsheet is by
pressing the arrow keys on your keyboard.)

Get some practice by clicking on individual cells in the spreadsheet. Notice the Name box, and how the
Cell coordinates change whenever you click on a new cell.

Before moving on, make sure you understand how the Grid coordinates work in a spreadsheet. If you are
asked to locate cell G4, for example, you should be able to do so quite easily.

In the next part, we'll see how to enter some text and some numbers into a cell.

<-- Back To Part One Move on to the Next Part -->

<--Back to the Excel Contents Page
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Entering Data into a Spreadsheet

To begin this part of the course, we'll do something really simply: we'll enter some text and numbers into
some cells. When we're finished, our spreadsheet will look like this:

A o =|
A | B |

1 |Mumbers
2 3
3 5
4 =
5 |

| ]
B

So, to enter something into a cell, do the following:

Click on cell A1 with your left hand mouse button

Type the text "Numbers" (without the quotation marks)
Press the Return key on your keyboard

The darker border will jump down one cell to A2

Type a 3 and then press the Return Key on your keyboard
The darker border will jump down one cell to A3

Enter a 6 and a 9 in exactly the same way

When you're finished, your spreadsheet will look like the one in the image above.

The word "Numbers" was our heading. We're not going to do anything to the heading. It is there purely for
our benefit, in order to serve as an explanation for what the numbers are.

Except "Numbers" is not very descriptive. Let's change it to something else. We'll change it to "Add these
numbers".

Editing data in a cell

When we wanted to enter some data in a cell, we simply clicked on an individual cell and started typing.
But you can't edit the data in a cell using that method. If there is already something in a cell, and you tried
to type something else, the old contents would be entirely erased. Try it for yourself.

Click on the cell A1

Type the letter "A" of "Add"

The word "Numbers" is erased

Click on Edit from the menu bar

From the menu that drops down, click on "Undo Typing"
The word "Numbers" will be restored

So how do you Edit the data in a cell? You have to do it from the Formula bar. The formula bar is the thin

Content downloaded from www.homeandlearn.co.uk



Created By www.ebooktutorials.blogspot.in
white text area running right across the top of the spreadsheet. You can see it in the picture below:

DEEe gRY 2R v @d = A8
A = = |
A | E | Formula Bar |0 | E | B

1 |Mumbers
2 3
3 B
4 g
5 |

L ]
a

Notice where it says "Formula Bar". The thin white text area just above the label is the "Formula Bar".
Notice, too, that there is some thin lines in the shape of an I. This is actually the mouse pointer. It has
changed shape, and is now an I-bar.

Click on the cell Al. Then click inside the formula bar. You will see your cursor flashing away. The
spreadsheet should now look like the one in the next picture.

IDede 2Ry R2R|l-@F =52 M
| X & = Numbers|
A E | ¢ | Db | E | F |
1 |Mumbers
2 3
3 B
4 g
5
B

The formula bar is displaying the contents of cell Al. To edit the contents, you can use the backspace key
on your keyboard to erase anything you don't want. And you can just type something new in the formula
bar. When you've finished editing, press the Return key on your keyboard.

In the next image, the text "Numbers" has been changed to "Add these numbers". Make the changes on
your own spreadsheet so that it look like the one below. Notice how the formula bar now reads "3" when
the Return key is pressed. The cell A2 is showing in the Name Bar.

A2 | - E
T E N T E E T e

1 |Add these numbers
2 g

L ]
3 5
4 9
5
B

Except we now have a problem: The text is too big for the Cell. It is spilling over into the B column. We can
solve that by widening the A column. This will be the subject of the next part.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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Widen an Excel Column

To widen a column, do the following:

Move your mouse pointer up to the letter A
The pointer will be in the shape of a white cross, as in the next image

A2 =
Acall B

Add these numbers

E]|

| |

5

g

o | DO | Pl | —

« Now move your mouse pointer, the white cross, to the line in between the A and the B

e The mouse pointer will change shape again

e The mouse pointer will be in the shape of a black cross with arrowheads, like the one in the image
below:

A2 =l

A + E
Add these numbers
|
1 ]
5
o

fo L2 | —

 When you mouse pointer changes shape, hold down your left mouse button
e Keep it held down and drag your mouse to the right
e Let go of the mouse button when your are satisfied with the width of your colum
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Centring Data in an Excel Cell

If you are following along from the previous sections, you should now have a spreadsheets with cells
highlighted. To centre the data in your four highlighted cells, do the following:

¢ Click on the word "Format" on the menu bar
e A menu drops down
e  Click on the word "cells" with your left mouse button

J File Edit View Insett | Format Tools Data Window Help

|03 Ha 8L -
Al [ Row '

A Zolumn

"]

1 |&dd these numbers Sheet 3
2 3

3 B AukoFarmat. ..

4 g Conditional Formatting. ..

5 Stwle, .,

5

When you click on the word "Cells" from the menu bar, you get a dialogue box popping up. The one below:

Format Cells

| Aligrrment I Foant I Border I Patterns I F‘rl:utectil:unl

ample
add these numbers

Category:

| Genersl ||
Mumber
CUrrency
Accounting
Date

Time
Percentage
Fraction
Scientific
Texk
Special

Custon ﬂ

General format cells have no
specific number Farmat,

[ |

The words across the top (Number, Alignment, Font, etc) are the headings for Tab Strips. The Tab Strip
that is showing is the Number tab strip. We'll meet this one a little later. We need the Alignment Tab Strip,
however. So click on the word "Alignment". The dialogue box will change to the one below:

Cancel |
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Format Cells ElE3
Murmber .':'||Il;|I'|I'I'|EI'|t Fant: I Border I Patterns I F‘ru:uteu:tiu:unl
Text alignment —2rientation

Horizontal: Indent: * .
IGeneraI j IU ﬂ *.
T .
Wertical; & Taxt —#
x )
IB:::ttu:um j r .
. *
.-
Texk control IIZI 5‘ Degrees
H Wrap bext
™ shrink ta Fit
[ Merge cells

(] 4 I Cancel |

The part of the dialogue box we're interested in is the "Text alignment” section. There are two drop down
boxes in this section: Horizontal and Vertical. The Horizontal drop down box has the word "General”; the
Vertical drop down box has the word "Bottom" in it. We'll change these.

¢ Click the little black down-pointing arrow on the right hand side of the Horizontal box
e Adrop down list appears

Format Cells EE
Mumber  Aligrnment | Fonk | Border | Patterns | F‘ru:uteu:tiu:unl
Text alignment —orientation

Horizontal: Indent: * .
— %
T
=
—
y Texk :
k .
. *
.
Zenter Across Selection

There are a number of options you can select for the Horizontal text alignment. Click on the word "Center"
with your left mouse button. Change the Vertical alignment in exactly the same way. When you're done,
click the OK button at the bottom of the dialogue box. Your spreadsheet will look like the one below:

A1 | =| Add these numbers
A E | ¢ |

_1 JAdd these numbers
=2 3
e 8 B

4 g

5 L ]

a]

All the data in the cells we highlighted is now centred. Before we do some other formatting, here's
something you can try:

e Highlight the cells A1 to A6
. Click on Format from the menu bar, then click Cells
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¢ Centre the Horizontal and Vertical text alignment, just like you have just done
e Your spreadsheet should look like the one below

A1 | =| Add these numbers
A N
1 | Add these numbers
2 3
3 B
4 9
H]
6
7
8

e Now, click on the Cell A5
e Type in the number 12
e Pressthe Return key on your keyboard

What happened? The number you entered should have been centred. The lesson to learn here is that you
can format a cell even if there is nothing in it!

OK, let's make our heading bold, and change the font, which we'll do in the next part.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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You can change the font of your text and numbers, and make it bold. You can also change the size of the
font and the font colour. We'll first format the text in the cell A1, from our spreadsheet in the previous

section.

Font formatting in Excel

To format the text in the cell Al, then, do this:

e Click on cell A1 with your left mouse button
. Click on Format from the menu bar

e  From the menu that drops down, click the word "Cells" with your left mouse button

e The Format dialogue pops up again
e This time, click on the word "Font", instead of "Alignment"
e Your dialogue box will look like the one below (in Excel 2000)

Format Cells EE3
Murnber | Alignrment ........... F Dntl Border | Patterns | F‘ru:uteu:tiu:unl
Font: Fonk style: Size:
|.ﬂ.rial |Regular I 10

] -
g
" Arial Black
T arial Marrow ;I 11 ;I
Underline:; Color:
IN:::ne j I Aukamatic j v Mormal font
fFects =0
[ strikethrough
I™ Superscript AaBbCcYyZz
[ Subscripk

This is a TrueType fonk, The same Fonk will be used on both wour printer
and wour screen,

(] 4 I Zancel

e From the dialogue box, change the Font Style to Bold
e Change the size to 8

¢ Click the OK button at the bottom

e Your spreadsheet will now look like the one below

The cells don't have to be white. You can change them to whatever colour you want. We'll add a spot of

colour the ours cells.

A1 | =| Add these numbers
A EE
Add these numbers 1
3
B
9
12

[ B R R S
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Changing the cell colour

To add a splash of colour to your cells, first highlight the cells you want to change. In our case, highlight the
cells A2 to A5. (We'll do cell Al after we've done the number cells.)

With the cells A2 to A5 highlighted, click on Format from the menu bar
From the drop down menu, click on "Cells"

The format dialogue box pops up once more

This time, click on the word "Patterns”

The dialogue box will now look like the one below

Format Cells EE |

Mumber I Aligriment l Fonk I Border EF‘atternsEl Prokection I

Zell shading
Colar;

“_L@ Mo Color

|
|
EEEEEENEN
HEEEENEE®E
ROCOCNEEERN
BOORCOEMEC]
EEmEER ‘Hm

EmOCmEm0]
EN [ EEEN

Pattern: I - I

ample

(0] 4 I Cancel |

Click on any of the coloured squares that takes your fancy. If you'd prefer a pattern, click the black down-
pointing arrow on the drop down box to the right of "Pattern”. Select a pattern that takes your fancy. When

your done, click the OK button at the bottom. Or you could click on the Font tab strip first, and change the
text to bold. Then click OK.

When you click OK, the cell colour will change from white to the colour or pattern you have chosen. If you

don't like it, you click on Edit from the menu bar, then click "Undo format cell". Or just try again and choose
another colour or pattern.

Once you have the numbers formatted in a different colour, click on the cell A1. Now do exactly the same

thing, only this time choose a contrasting colour for the text. Your spreadsheet will now look something like
the one below:

s = =]
A | B
1 | Add these numhbers
2 3
3 5
4 9
5 12
6
L7
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Time now to save all your hard work, which we'll do in the next part.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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Saving your work in Excel

Time now to save what you've done. To save your spreadsheet in Excel, do the following:

e Click on "File" from the menu bar

e  From the menu that drops down, click on "Save"

* If you have not yet saved your work, the Save As dialogue box will pop up. Clicking Save otherwise
will save the latest version of your work. In other words, your saved work will be updated

e The Save As dialogue box is this one below

Save As EE
Save in: II:l spreadshests j = | o + Tools -

@sectiunl Jls
-

«'

My Documents

File name:

sectionl, xls j H Save I
Web Folders -
Save as bype: IMlu:ru:usu:uFt Exccel Workbook, (*,xls) j Zancel |

The Save As dialogue box is split into three basic sections: Where do you want to save it; the files already
in that location; and what do you want to call your file. Let's examine the first section more closely - Where
do you want to save it .

The top of the dialogue box looks like this:

Save As EE
Save in: II:l spreadshests j = | @ > @ * Tools -

Fsectiunl Jls

Just to the right of the words "Save in" is a drop down box. At the moment it says "spreadsheets”, and
there is a little folder icon next to it. This is telling us that there is a folder on our hard drive called
"spreadsheets”. We're saving our new work in this folder. If we click the black down-pointing arrow, we get
this:
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Save in; [ spreadshests -
# Deskkop =r
{ My Computer
o % Weh Folders
314 Floppy (8:)
=2 ()

«'

My Docurnents

&
=3 Metwork Meighborhood
sy My Documents
=Y FTP Locations

)

AddfModify FTP Locations ¥

You can change where you want your work to be saved by clicking on any of the locations on the list. This
drop down box is telling is that we have a folder called spreadsheets. This spreadsheets folder is inside
another folder, called Excel. The Excel folder is on the C drive.

By creating a folder called spreadsheets, which is inside a folder called Excel, we can keep track of where
our work is more easily. Just saving it anywhere on the C drive is not a good idea: it's often very difficult to
find the work again when it's needed.

So we have a folder called "spreadsheets”. The next section of the Save As dialogue box, the big white
area, shows the files already in that location. In the image, only one file was showing - sectionl.xls. We
can add as many files as we like to our spreadsheets folder. To do that, we need the third part of the Save
As dialogue box. This part:

File name:

j H Save I
Save as bype: IMicrnscht Excel Workbook, (*,xs) j Zancel |

The File name is already highlighted. We can type something else there, a new name for our file. Type in
anything you like, and then examine the box below it- Save as type. The box says "Microsoft Excel
Workbook". This is exactly what we want, so no changes are needed. But if you click the black down-
pointing arrow, you'll see other options: Web page, Template, Text, and so on.

But click the Save button when you've chosen a File name, and set the Save as type to "Microsoft Excel
Workbook(*.xIs)".

Your new spreadsheet is saved. Keep clicking File > Save on a regular basis to keep updating your
work. Alternatively, click the Save icon on the toolbar:

J File Edit Yiew Insert Format Tools
DS Ee SRY 2@
My =

[ Save| [ = [

OK, the time for your first Excel Project. It's a nice and easy one, so there's no need to worry.

<-- Back One Page Move on to the Project -->

<--Back to the Excel Contents Page
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Excel Projects - Project One

The picture below shows a simple spreadsheet. There are no formulas in it, and nothing is being added up
or subtracted (we'll do that in the next section).

J File Edit %ew Insert Format Tools Data ‘Window Help Acrobat

DEELGRY BR - @@= 42 @
A | B | C | D | E |

1 Shopping Bill

2

_4 | Mars Bars 4 £0.35

5 |  Twixes 10 £0.32

B | Aeros 4 £0.39

L Crisps 12 £D0.35

8| Pop 4 £0.59

[0

1o}

Bhl

L

For Project Number 1, reproduce the spreadsheet above (the famous junk food diet!). Your spreadsheet
must include the following:

Centred text and numbers

Widened columns

Bold font for the text and numbers
Background colours or patterns for the cells

PoONPE

In the prices column, you'll notice that the Currency sign has been included. To get theCurrency signs in
your spreadsheet, do this:

e  First enter a number for the price, but enter a zero then a full stop first, then the numbers. So enter
0.35 for the first price and not just 35

When you have all five prices, highlight the cells C4 to C8

With the cells highlighted, click on Format from the menu bar

From the menu that drops down, click on "Cells"

You'll get the familiar Format Cells dialogue box popping up

e Click on "Number", and change your setting to match the ones in the dialogue box below
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Format Cells EHE3
Murnber I.ﬁ.lignment I Fank I Border I Patterns I F‘ru:ute-:tiu:unl
Cateqary; ample
zeneral ;l £0.35
rurnber

Decimal places: |2 5‘
Accounting

Diate Syrbol:

Timne |£ j

F‘erce-:ntage Megative numbers;

Fraction

Scientific

Texk £1,234.10

Special -£1,234.10

Custom Fl |-i73410 =i

urrency Formats are used For general monetary walues, Use Accounting
Farmats ko align decimal painks in a calumn,

(0] 4 I Cancel |

The changes to make are: click on Currency from the Category section; and make sure the Decimal Places text
box has a 2 in it. Then click the OK button at the bottom.

Good Luck!

<-- Back One Page Move on to the Next Section-->

<--Back to the Excel Contents Page
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Constructing an Excel Spreadsheet

In this section, we'll construct a spreadsheet and learn about: Auto fill, inserting rows and columns, adding
up numbers in columns, formulas, and the formula bar. The spreadsheet we will construct will look like this
when it is finished:

Click here to see the Spreadsheets you will construct

As you can see, not much formatting has been done. We'll concentrate on getting the sums right in this
section. But you can format your spreadsheet, if you like.

So, let's get started on the "Chocolate Addiction” spreadsheet.

Click on cell A1 with your left mouse button

Enter the text "My Chocolate Addiction" (without the quotes)
Press the Return key on your keyboard

Your spreadsheet will look like the one below

A | B | ¢

My Chocolate Addiction
|

| O | e | DO Pl | —

If you now click in cell Al, you'll see the darker border surrounding that cell. Click inside B1 and the darker
border surrounds that cell. Likewise, with cell C1. In other words, they are all individual cells behind our
heading. We'll turn those three cells into one cell.

Highlight the cells A1, B1 and C1
Your spreadsheet will look like the one below

Al | =| My Chocolate Addiction

A | B | c© | D

| E

hy Chocolate Addiction

o | L0 B | e

From the menu bar, Click on Format

From the drop down menu, click on "Cells"

The familiar Format Cells dialogue box pops up

Click on the Alignment tab strip

Look for the box at the bottom that says "Merge cells"

Put at tick in this box by clicking it with the left mouse button
Your dialogue box should look like the one below
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Format Cells EE3
Mumber  Alignment | Font I Border I Patterns I F‘ru:uteu:tiu:unl
Text alignment —orientation

Horizontal: Indent: * .
IGeneraI j IU ﬂ s
T :
Wertical; & Taxt —#
% ;
IB:::ttu:um j k .
. *
.-
Text control ||:| 5‘ Degrees
r Wirap bext
™ shrink ta Fit
Wtéﬂ%ﬁﬁéﬁ%ﬁﬁ%ﬁ'ﬁlﬁéﬁé

(0] 4 I Cancel |

In the dialogue box above, there is a tick inside the box "Merge cells". Click the OK button when you're
done. But you can centre your text while the Alignment tab strip is displayed.

Your spreadsheet will now look like the one below:

Al | =| My Chocolate Addiction
A | B | C D [ E |
by Chocolate Addiction

o | L0 B |

Now, when you click on cell B1 or cell A1, the Name box will read Al. All three cells have now been
merged. The text "My Chocolate Addiction" is entirely in cell Al.

In the next part, you'll learn all about Autofill.

Move on to AutoFill in Excel -->

<--Back to the Excel Contents Page
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How to Use AutoFill in Excel

AutoFill is a very handy feature of Excel. It allows you to quickly fill a series of data, such as days of the
week, months, and consecutive numbers. We'll see how it works.

Click inside the cell B3 on the spreadsheet you started in the previous section, and type the text Monday.
Like this one below

B3 | =| Monday
A | B | ¢ | D |
by Chocolate Addiction

IMDndaE _l

M| b |l | 0| —

We're going to put the days of the week on the same line, on row 3 of our spreadsheet. But we don't have
to type out the rest of the days. We only need to enter Monday, and we can do something called an Auto
Fill. With Auto Fill, Excel will "Automatically Fill" in the rest of the days of the week for us. You do it like this:

e Move your cursor to the bottom right of the B3 cell

e Your cursor will change shape from a white cross to a black cross, as in the images below. The one
on the left is the normal cursor, and the one on the left is the one we're after
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Entering Data into an Excel Spreadsheet

So we've got a heading at the top of our spreadsheet, and some days of the week headings. We can now
enter the chocolate bars. So click on cell A4 and type in the text "Mars Bars" (without the quote marks).
Next enter Twix, Bounty and Others. In cell A9, enter the text "Day Totals". Your spreadsheet should now
look like the one below:

LS (< S T = - |
My Chocolate Addiction

Monday Tuesday Wednesd: Thursday Friday  Saturday Sunday
Mars Bars
Twix
Bounty
Others

Day Totals

o
=

Time to enter some numbers now.

e  Forthe Monday column, click on cell B4

e  Enter the number 1 then press the Return key on your keyboard
e Enter the number 7 then press the Return key on your keyboard
o  Enter the number 8 then press the Return key on your keyboard
e Enter the number 1 then press the Return key on your keyboard
e Your spreadsheet should now look like this one:

L E I EE| D [ = 1 = 1T & 1T &
1 My Chocolate Addiction
2
3 Monday Tuesday Wednesday Thursday Friday Saturday Sunday
4 |Mars Bars 1
5 |Twix 7
E |Bounty 8
7 |Others 1
8
8 |Day Totals
10

You now need to enter the rest of the numbers. Enter the following figures for the rest of the week:
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Entering Formula into an Excel
Spreadsheet

What we want to do in our spreadsheet from the previous page is to add the daily columns. The four
numbers for Monday need to be added up; the four numbers for Tuesday need to be added up; the four for
Wednesday, and so on. The totals will go into the cells below, in our Day Totals row.

In a spreadsheet, you have to "tell" Excel which cells you want to add up. So for the Monday column, the 1
is in cell B4, the 7 is in cell B5, the 8 is in cell B6, and another 1 in cell B7. So we want the answer to B4 +
B5 + B6 + B7.

To let Excel know that is the sum we want working out, do this:

e Click in the cell where you want the answer to appear (This is cell B9 for us, the first of the Day
Totals)

e Now click inside the formula bar

e Typeinthis: B4 + B5 + B6 + B7

e Your spreadsheet should look like the one below

B9 =%« =] B4 +B5 + BE +B7]

S D |E T e
1 My Chocolate Addiction
2
3 Monday Tuesday Wednesday Thursday Friday |Saturday Sunday
4 |Mars Bars 1 2 1 3 3 2 5
5 |Twix 7 ] 3 2 4 2 4
E |Bounty 8 3 2 3 4 1 4
7 |Others 1 2 2 2 2 1 1
a
9 |Day Tutalsliﬁ + BY ‘|
10

Notice that the Name box top left says B9. This is the cell where we want the answer to appear.
When you have entered the formula in the formula bar, press the return key on your keyboard.

Your spreadsheet will look like the one below:

A | B | © | D E T

1 My Chocolate Addiction

2

3 Monday Tuesday Wednesday Thursday Friday Saturday Sunday
4 |Mars Bars 1 . 1 3 3 2 5
5 |Twix 7 ] 3 2 4 2 4
E |Bounty 8 3 2 3 4 1 4
7 |Others 1 2 2 2 2 1 1
g

9

Day Totals B4 + B5 + B6 + BY

=
(]

Something has clearly gone wrong! We were expecting Excel to add up the numbers in those cells. Instead
it has entered the cell references themselves: B4 + B5 + B6 + B7.

The problem is that Excel thinks you want text in the cell B9. When we entered B4 + B5 + B6 + B7 in the
formula bar we didn't "tell" Excel to add up. So when we pressed the Return key, Excel thought it was just
text.
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To "tell" Excel to add up, you need an equals sign first. We'll also use the Sum function. The Sum function
looks this:

=Sum()
You put what you want to add up in between the two brackets. So we would need this:

=Sum( B4 + B5 + B6 + B7)

So go ahead and enter that in the formula bar. Before you press the Return key on your keyboard, your
spreadsheet will look like this:

=] X =] =5UM(B4 +B5 +BE + E7)
T e T E e e E e

1 My Chocolate Addiction

2

3 Monday Tuesday Wednesday Thursday Friday Saturday Sunday
4 |Mars Bars 1 2 1 3 3 2 5
5 |Twix 7 ] 3 2 4 2 4
E |Bounty 8 3 2 3 4 1 4
7 |Others 1 2 2 2 2 1 1
8

9

Day Tutalsliﬁ + B?i ‘|

=
O

When your spreadsheet looks like the one above, press the Return key on your keyboard.

Finally, Excel understands what you want to do. It adds up the numbers in the cells you gave it, and puts
the answer in cell B9. Your spreadsheet now looks like this one:

B9 -] =| =SUM( B4 + BS + B + B7)
TS [ - [ S = [ =l [ [

1 My Chocolate Addiction
2
3 Monday Tuesday Wednesday Thursday Friday Saturday Sunday
4 |Mars Bars 1 2 1 3 3 2 5
5 |Twix 7 ] 3 2 4 2 4
E |Bounty 8 3 2 3 4 1 4
7 |Others 1 2 2 2 2 1 1
8
9 |Day Tutalsl 1?!
10

Notice what is happening in the Name box and the formula bar. The cell B9 is highlighted and displayed in
the Name box top left. The formula bar is telling you what you have in cell B9. In this case it is the Sum()
function. In between the brackets is what we want to add up: B4 + B5 + B6 + B7.

But suppose you had a very long column to add up. Suppose you wanted to add up the cells B4 to B44.
Would you really have to enter B4 + B5 + B6 + B7 + B8 + B9 + B10 + B11, and so on right up to B44?

Fortunately not. There is a shorthand that Excels understands, when you want to add up consecutive cells.
You use the colon. You type the first cell you want to add up, then type a colon. After the colon, you type
the last cell that you want to add up. It would look like this:

=Sum(B4: B44)
The colon means: "Add up all the cells between the one on my left and the one on my right.”
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This page is getting a bit long now, so you can continue the lesson by clicking the link below.

<-- Back to Entering Data | Continue this lesson on Formulas -->

<--Back to the Excel Contents Page
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Adding up Rows in Excel

In this section, we're going to use the Chocolate addiction spreadsheet from the last section. We'll add to it,
and learn how to do some multiplying. We'll also learn how to copy and paste numbers from one column to
another. We'll get some more practice with adding columns and rows.

In the last section, you saw how to add up a column of numbers. The long way to do it was this = Sum(Al + A2
+ A3 + A4 + A5). But for a column of consecutive cells, you learnt that there was an easier way. This: =
Sum(Al: AS).

We can use that last formula to add up a Row of consecutive cells, too. So, click on cell J3 of your spreadsheet
and enter the text "Individual Totals". Widen the column a bit. Your spreadsheet should now look like the one
below:

TR _ﬂ "B
5 =5 e 3 = 51 i e s i J |
1| My Chocolate Addiction
2
3 Monday Tuesday Wednesday Thursday Friday Saturday Sunday Individual Totals
| 4 |Mars Bars 1 ? 1 3 3 2 ] | |
5 |Twix 7 5 3 2 ] 2 4
B |Bounty 8 3 2 3 4 1 4
7 |Others 1 2 2 2 2 1 1
g
8 |Day Totals 17 12 ] 10 13 6 14
10

What we're going to do now is add up the Rows. We want to know how many Mars Bars are eaten in any one
week, how many Twix, how many Bounty bars, and how many Other bars. So the sum is the Monday total,
plus the Tuesday total, plus the Wednesday total, plus the Thursday total, plus the Friday total, plus the
Saturday total, plus the Sunday total.

If we start on the Mars Bars, we need to know which cells we want to add up. Then we tell Excel to do the
sum. The first Mars Bar total is in cell B4, the second is in C4, the third in D4, the fourth in E4, the fifth F4, the
sixth in G4, and the seventh total is in H4. So those are the cells we want to add up. As they are consecutive
cells we can use the colon - B4:H4.

Next we decide where we want Excel to put the answer. We've just added a new headings called Individual
Totals. This was in the J column. The Mars Bar heading was on Row 4. So the first total needs to go into cell
J4.

So click on cell J4 with your left mouse button
Click inside the formula bar at the top
Type in the following formula:

=Sum(B4:H4)

Hit the Return key on your keyboard
The answer to all that addition should appear in cell J4

Once we have the answer in cell J4, we can use Auto Fill to get the answers to the other 3 Rows.

. Click on cell J4
e Move your mouse to the bottom right of the cell
e The cursor turns into a black cross, as in the image below
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[ J [
Sunday Individual Totals
5 I 171
4 T
4
1
14

¢ When the cursor turns into a black cross, hold down your left mouse button
o Keep the left mouse button held down and drag your mouse downwards to cell J7

[T ER | J [
Sunday Individual Totals
5 17
4
4
1 A
I
14

When your cursor gets to cell J7, let go of the left mouse button. Excel will Auto Fill the other three cells,
inserting a formula based on the first one. The J column of your spreadsheet now looks like the one below:

) J I
Sunday Individual Totals
5 17
4 pr
4 25
1 11

14

Click on any of those four cells in the J Column. Then take a look at the formula bar to see the formulas. Make
sure you understand what is being added up in each Row, and how the answer is derived.

All right, we have the individual total for the chocolate bars. But we can also work out how many chocolate
bars are eaten in any one week. The grand total, in other words.

e Clickoncell A11

o Enter the text "Number of Chocolate bars consumed in a week"

e Press the return key on your keyboard

e Click back in cell A11

e Highlight all of your new text and merge the cells (Do you remember how to do this? Click on Format
from the menu bar. From the drop down menu, click Cells. Click the alignment tab strip in the dialogue
box that pops up. Put a tick in the bottom box "Merge cells".)

¢ Centre your new text and make it bold. The font should be Arial, 10 points

From our spreadsheet, there are two ways we can find out what the weekly total is. One way would be to add
up all the Individual Totals in the J column. The other way is to ... Well, what is the other way? What else could
we add up to get the weekly total? We're sure you'll have no problem coming up with the answer.

Exercise

e Click inside cell F11
e Enter a formula to calculate the weekly total
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e Press the Return key on your keyboard when you have the correct formula
e  The answer should be 80

In the next part, we'll take a look at how to copy and paste in Excel.

Move on to the Next Part -->

<--Back to the Excel Contents Page
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Copying and Pasting in Excel

OK, 80 chocolate bars in one week is a lot of chocolate bars. But how much is this addiction costing every
week? How much is it costing per year?

We can work this sums out quite easily. First, we'll need some text headings.

¢ Click inside cell A13 and enter the text "Cost of Addiction”

e Merge the text into one cell, just like you did in the last part

 Format the text: bold, centre, a coloured font or background, if your prefer
« When you have finished, press the Return key on your keyboard

We'll now copy and paste some text.

e Click inside cell A4, then highlighted the cells down to A7 (the cells A4, A5, A6 and A7 should be
highlighted)

e  From the menu bar, click on Edit

¢  From the menu that drops down, click copy

e There should be some sort of animated line around your highlighted cells - the marching ants!

A4 | E
A [ B |
My Chocolate Adc

Mars Bars 1
Twix 7
Bounty 8

1

GO | OO0 | =l | S | Y | e | 0| B | —

Day Totals 17

« When you see the marching ants, click inside cell A15 of your spreadsheet
e Pressthe Return key on your keyboard
e The text should have been copied to the new location, and your spreadsheet will look like the one

below
1| My Chocolate Addiction
2
£an) Monday Tuesday Wednesday Thursday
.4 |Mars Bars 1 2 1 3
5 | Twix 7 5 3 2
B |Bounty 8 3 2 3
¢ |Others 1 2 2 2
g
.9 |Day Totals 17 12 L] 10
10
11| Mumber of Chocolate bars consumed in a week:
12
13| Cost of Addiction
14
15 |Mars Bars
1B | Twix
17 |Bounty
18 | Others
1
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We'll enter some more headings, so that we can work out how much this addiction is costing.

. Click inside cell B14 and enter Price
. Click inside cell C14 and enter Number
. Click inside cell D14 and enter Cost

The spreadsheet now looks like this:

e D | E |
.1 | MycChocolate Addiction
2
13| Monday Tuesday Wednesday Thursday
|4 |Mars Bars 1 2 1 3
.5 | Twix 7 5 3 2
| B |Bounty L] 3 2 3
.7 |Others 1 2 2 2
g8
|8 |Day Totals 17 12 L] 10
0]
11| Mumber of Chocolate hars consumed in a week:
12
(13| Cost of Addiction
14 Price | Number Cost
|15 |Mars Bars
L1B | Twix
|17 |Bounty
|18 |Others
9

Under "Price" is where we'll put the price of each chocolate bar. Under "Number" we'll put the number of
each bar eaten in a week. Under "Cost" is where we'll find out how much is being spent each week on the
individual chocolate bars. In other words, how much is being spent on Mars Bars, how much on Twix, how
much on Bounty Bars, and how much on Others.

So enter some prices. Our researchers have been out and about eating chocolate bars. They found that
prices for each chocolate bar are these:
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How to Multiply figures in Excel

This time, we need to multiply the cost of each bar by how many were eaten. So we want to multiply the
Price by the Number. The Price is in the B column and the Number is in the C column.

We want the answer to appear in the Cost column. So click inside the cell D15. If you wanted to multiply
two numbers together the standard mathematical notation is this:

35 x 17 =595

However, Excel doesn't use the X symbol to multiply. Simply because it would be confused with the letter
X. Instead the asterisk symbol is used. The asterisk symbol is the one above the nhumber 8 on your
(English) keyboard. So the sum above would be this in Excel:

35* 17 =595

It's very easy to multiply two numbers together using Excel. When we were adding up we used the =Sum()
function. In between the brackets we told Excel which cells we wanted to add up. You don't need a function
when you are multiplying; all you need to do is "tell" Excel which cells you want to multiply. So do this:

e Click inside the cell D15
e Click inside the Formula Bar at the top
e Type this:

=B15 * C15

e Then press the Return key on your keyboard
e Excel should give you the answer £5.95
e Your spreadsheet will look like the one below

D15 | =| =B15*C15

L TEE D E T E
.1 | My Chocolate Addiction
2
L3 Monday Tuesday Wednesday Thursday Friday |Saturday Sunday
|4 |Mars Bars 1 2 1 3 3 2 5
L& |Twix 7 5 3 2 4 2 4
_ 6 |Bounty 8 3 2 3 4 1 4
_ 7 |Others 1 2 2 2 2 1 1
g
.89 |Day Totals 17 12 8 10 13 6 14
10
(11| Mumber of Chocolate bars consumed in a week: g0
12
13| Cost of Addiction
14 Price | Humber Cost
15 |Mars Bars £0.35 1?| £5.95_|
1B | Twix £0.29 &7
17 |Bounty £0.32 25
18 |Others £0.40 11
1

So when you want to multiply use this formula:
= Cell reference * Cell Reference
In the formula bar in the image above, you can see the actual formula used:
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=B15 * C15

Once we have that formula in place, we can Auto Fill the others. You should know how to do this by now.
So Auto Fill the other three costs and your spreadsheet should look like this one:

11

12

IS

14

15

16

1

13

19

Number of Chocolate bars consumed in a week: ad

Cost of Addiction
Price
Mars Bars £0.35
Twvix £0.29
Bounty £0.32
Others £0.40

Humher
17
27
25
11

Cost
£5.895
£7.83
£5.00
£4.40

Make sure your totals in the Cost column are the same as the ones in the image above. You can then

move on to the next part.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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Working out Weekly and Annual Sums

OK, so what else can we do to our spreadsheet? Well, we can work out how much this addiction is costing
each week.

You have the individual costs of each chocolate bar. So all you need to do is add the Cost column up. So
enter a suitable heading, something like "Weekly Cost of Chocolate Addiction”. Next, enter a formula to
add up the Cost column, so that you have a figure for how much is being spent on chocolate bars each
week. When you are done, your spreadsheet should look like the one below.

F20 | =| =SUM(D15:D18)

A | B | ¢ | D [ = = Ol aE ]
2
3 Monday Tuesday Wednesday Thursday Friday Saturday Sunday
4 |Mars Bars 1 2 1 3 3 2 ]
5 |Twix 7 ] 3 2 4 2 4
E |Bounty 8 3 2 3 4 1 4
7 |Others 1 2 2 2 2 1 1
8
S |Day Totals 17 12 8 10 13 6 14
10
11 Number of Chocolate bars consumed in a week: 80
12
13| Cost of Addiction
14 Price | Number Cost
15 |Mars Bars £0.35 17 £595
16 | Twix £0.29 27 £7.83
17 |Bounty £0.32 25 £5.00
18 |Others £0.40 11 £4.40
19
20 Weekly Cost of Chocolate Addiction: I EE.1B!
21

The formula to add up the Cost column has gone in cell F20. As you can see, the total is £26.18 per week.
A lot of money to spend on chocolate bars!

We can also work out how much the addiction costs each year.

Enter some text for the yearly total. In the spreadsheet above, we would just click on cell A21 and enter the
text "Annual Cost of Chocolate addiction". We would then want the answer to appear in cell F21, right
under the Weekly total of £26.18.

But what's our formula?

We know that there are 52 weeks in a year. We spend £26.18 on chocolate bars every week. So the sum is
quite simple:

= F20 * 52

e Soclick inside cell F21

¢ Click inside the formula bar

e  Enter the formula above

e  Press the Return key on your keyboard

e The correct figure should appear in cell F21

e Your spreadsheet should now look like the one below:
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13| Cost of Addiction

14 Price Number Cost

15 |Mars Bars £0.35 17 £5.05

16 | Twix £0.29 27 £7.83

17 |Bounty £0.32 25 £3.00

18 | Others £0.40 11 £4.40

19

20 Weekly Cost of Chocolate Addiction: £26.18
g; Annual Cost of Chocolate Addiction I £1 ;361.35!

The formula you just entered demonstrates that you can mix cell references with real numbers: you don't
need to enter cell reference in formulas, and only cell references. In fact, you don't even need to enter a
cell reference at all. You could have entered this in the formula bar instead:

=26.18 * 52

Excel wouldn't mind either way. It would mind, however, if you tried to enter the pound sign in the formula
bar. To get the pound sign you would need to format the cell to Currency.

And that completes our Chocolate Addiction spreadsheet. At an annual cost of one thousand, three
hundred and sixty one pounds and thirty six pounds it is definitely time to quit!

The next part is the final paret of section section three, and it's all about how to add comments to your
excel spreadsheets.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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How to Add a Comment to a Cell In Excel

You can add comments to a cell, if you want. To see how they work, take a look at the spreadsheet below:

B1 =] =| =RANDBETWEEN(1, 49)
A B T EE
1 | First Lottery Ball 141

3

The function in cell B1 generates a random number from 1 to 49. You can get it to generate a new random
number by clicking inside the formula bar and pressing the return key on the keyboard.

We'll add a comment to the cell to let anyone using the spreadsheet know what to do.

First, construct the spreadsheet above. For the RANDBETWEEN( ) function to work, you have to enable it.
To enable the function, click on Tools from the menu bar. From the drop down menu, click on Add-ins. A
dialogue box pops up. Click on Analysis Toolpack and then click OK.

If Tools > Add-ins doesn't work, you can enter this formula in cell B1
=RAND() *49 +1

The formula will generate a Random number between 1 and 49. You then need to format the cell to
Number and set the decimal places to zero.

Once you have the above spreadsheet up and running, you can add your comment. To add a comment to
cell B1, do the following:

Click on cell B1

From the menu bar, click on Insert

From the drop down menu, click on Comment

A yellow text box will appear to the right of cell B1, as in the image below:

= | =]
A g e
First Lottery Ball g AKaYs:

M k= L b —

Excel will add to the comment the name of the person who's computer it is. In this case it was done on
Kays computer. You can delete this name by pressing the backspace key on your keyboard.

To add your comment, just start typing. You can enlarge the text box by holding down your left mouse
button on one of the white squares and dragging.

_ 8 | ¢ | b | E | F |

# Click inside the Formula bar

22 Hand press the return key to
£{generate a new random
Hnumber
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Click on any other cell in your spreadsheet and the comment will disappear. The cell will have a red
triangle in the top right corner, indicating that it contains a comment. Like the one below. Though this is a
black and white image, so the effect is not too apparent:

A | B | ¢
First Lottery Ball | o
L]

1
_2 |
3

If you move your mouse over cell B1 the comment will pop up. Try it and see.
If you want to get rid of a comment, do the following:

e Click inside the cell that contains the comment

¢  Click once with your right mouse button

e A menu appears

¢ Click "Delete Comment" with your left mouse button
e  The comment is deleted

And that completes section three of the excel spreadsheet course. You can have a go at the project below,
or move on to section four.

Project Two-->

Move on to the Section Four -->

<--Back to the Excel Contents Page
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Project Two

You have just created a spreadsheet on Chocolate addiction. Time now to reveal your addiction!

Create a spreadsheet like the one in the last section, but substitute Chocolate Addiction for something
else. Examples might be: smoking, drinking, eating out, clothes, make-up - in fact, anything that someone
might be spending too much money on. (It doesn't have to be you doing the spending; it can be entirely
made up.)

Your spreadsheet must include the following:

e Daily totals

. Individual totals

e  Weekly total

e  Columns for Prices

e  Columns for Number and Cost
e Weekly cost

e Annual cost

You can format the spreadsheet any way you like. The colour scheme is entirely up to you. Just make sure
that your spreadsheet is easy to follow.

Move on to the Section Four-->

<--Back to the Excel Contents Page
View all our Home Study Computer Courses
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Sorting Data in an Excel Chart

In this section you'll learn how to create a chart from data in a spreadsheet. You'll also learn how to sort
data. Sorting data and charts are not part of the same subject: you can sort data without having a chart,
and have a chart without sorting data. But sorting data sometimes comes in useful, so we'll tackle it now,
and used our sorted data to create our chart.

Before we start this section, though, you need to create the spreadsheet below. Type in the data exactly as
it is in this one:

A EE 2 D | B |

.1 |Miewing Figures March 3 2002 (no soaps)

2
L3 | BEC 1 T+
4 Millions Millions
|5 |Halby City £.99 Who... Millionaire 10.99
LB |%icar of Dibley b.34 Heartheat 10.22
|7 |Changing Rooms 758 Bad Girls 742
|8 [DIY 505 .20 The Bill 5.54
|8 |Lenny Henry .03 The %ice B.37
10 | Antiques Roadshow 7 6o Blind Date B.31
.11 |Ground Force B.71 stars in their Eyes B.26
12 |Casualty 8.8 Footballers Yyives B.17
|13 |Ready Steady Cook 6.33 Champions League B.09
_14 |Mational Lottery B.27 Inspector Marse 5.81
Lo

16

The spreadsheet above shows the viewing figures for BBC 1 and ITV. The soap operas Eastenders and
Coronation Street are not included. The ITV programmes have already been sorted, but the BBC
programmes have not. We'll sort the BBC programmes now.

Sorting the Data

After we sort the BBC1 programmes, the highest viewing figures will be at the top and the lowest at the
bottom. This is a Descending sort. If we were sorting the other way around, with the lowest first and the
highest last then it would be a Ascending sort.

Before you can sort data, you need to "tell" Excel what you want to sort. You "tell" Excel by highlighting the
data. So highlight the BBC 1 programmes and the figures. Your highlighting should look like the one in the
image below.

3 BEC 1

4 Millions

8 |Holby City 5.99
6 |%icar of Dibley B.34
7 |Changing Rooms 7.38
g |0y 303 7.20
9 |Lenny Henry 7.03
10 |Antiqgues Roadshow /.68
11 JGround Farce B.71
12 |Casualty 8.82
13 |Feady Steady Coaok b.33
14 |Mational Lottery 5.2?_
15

To sort the BBC 1 figures, do the following:
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e  From Excel's menu bar, click Data
e  From the drop down menu, click Sort
e Adialogue box appears

Sort EHE

* fscending
™ Descending

* fscending
" Descending

I L‘ ' ascending
" Descending

My lisk has

% Header row ™ Mo header row

options. .. | I, I Zancel |

In the Sort By box it says "Column A". To the right of this there a Ascending radio button and a Descending
radio button. The Sort By box is actually a drop down list.

¢ Click the word Descending to select this option
¢  Click the black down-pointing arrow on the Sort By box
e From the drop down list, click on Millions

You could click the OK button right now and the data would be sorted. But what about those "Then By"
boxes? What do they do? Well, suppose two of the programmes had exactly the same viewing figures. We
have chosen to Sort By the Millions column, the numbers. If two programmes had the same numbers we
could specify what to sort on next. If you click the black down-pointing arrow of the first "Then By" box
you'll see a drop down list. It's the same list as the Sort By box. Select "Column A" and Descending. If two
programmes had the same viewing figures, Excel will then look at Column A. It will see text in this column.
It will then sort the two programmes that have "drawn" into alphabetical order.

So the "Then By" boxes are for what happens in the event of a draw. You choose which column to sort on
next. But click the OK button when your dialogue box looks like the one below:

Sort EHE
Sork by

iliors ______Ad

™ Ascending

% Descending

Then by
||:C|:|Iumn & | " ascending
¥ Descending
Then by
I LI &% pscending
" Descending
My lisk has
& Header row " Mo header row

options, .. | Ok, I Zancel

Your BBC 1 Viewing figures should now look like this:
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IMillions

And that's all you need to do for the sort. We can move on to creating a Chart from our data.

Move on to the Next Part -->

<--Back to the Excel Contents Page
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How to Create a Bar Chart in Excel

OK, we're going to make a chart out of the BBC1 Viewing figures we created in the last part. The chart
we're going to create will look like the one below, when it's finished.

Viewing Figures

Mational Lottery
Ready Steady Cook ]
\icar of Dibley |
Ground Force ]
Holby City |
Lenny Henry ]
DIY 505 |

Changing Hooms

Programmes

Antiques Roadshow

Casualty |

0.00 200 4.00 B.00 8.00 10.00

Millions

To start making your chart, you need to highlight the data that will make up the chart.

e So highlight the BBC1 programmes and the viewing figures
e From the menu bar, click on Insert
e  From the drop down list, click Chart

Insert Format Tools Data

Zells...
Rows
Columns
Wiorksheet

i S N

Page Break,

F+ Function. ..
Mlarne k
ﬁ Commenkt

Picture 3
Object. ..
% Hypetlink, ..  Chrl4k

When you click on Insert > Chart, the Chart wizard appears. It looks like the one below:
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Chart Wizard - Step 1 of 4 - Chart Type EE

Standard Twpes | Zustom Twpes I

Chart type: Chart sub-kype:

iy Radar
|l Surface

@ Bubble

[ﬁiﬁ_ Skock, ;I

o WY (Scatker)
|‘ Area
i@ Doughnut !

Clustered Column, Compares values across
categories,

Press and Hold to Wiew Sample |

Cancel | < Back | Mext = I Einish |

There is a four step process to go through with the wizard. The first step is to select a chart type. The Chart
Type showing in the image is a column chart. To see what this will look like, click the button "Press and
Hold to View Sample". Click with the left mouse button, and keep the button held down. You see a preview
of what the chart will look like.

Chart Wizard - Step 1 of 4 - Chart Type EHE

Standard Tvpes | Custam Twpes I

Chart tyvpe: Sample:
17 =
10.00
9.00
B Bar &00
i 7.00 H =
|ﬁ Line T00. T
i Fie s.00 H
400 4 I
= WY (Scatker) 3.00 4 HHH
2 z.oo 4 I
|‘ Area 1.00 HHMH
oop AL W BT
@ Doughnut £ & F & %
) o
il Radar E & i kh e
— m =
| Surface = 80 g 2
H o =
@+ Bubble " -
[ﬁiﬁ_ Stack. ;I :

Clustered Column, Compares values across
cakteqaoties,

Cancel | < Back I Mext = | Eimish |

Let go of the left mouse button and you are returned to the chart types. The chart we want is Bar. So click
on Bar in the Chart Types list. You'll see some different Bar types under Chart Sub Types. Make sure the

first one is selected.
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Chart Wizard - Step 1 of 4 - Chart Type EdE3

Standard Types | Zustom Twpes I

Chart type: Chart sub-type:
M Colurmn =] k |
= R — .
|ﬁ Line E |
@ Pie
s BY (Scatker) *=-
[ty Are=a =q
=
i@ Doughnut ]
il Radar
| Surface b
®: EBubble
g Stock ;I
lustered Bar. Compares values across
ateqories,
Press and Hold to Yiew Sample |

Cancel < Back I Mext = I Einish |

Click the Next Part link below to continue this lesson.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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How to Format an Excel Chart

To formart the chart you created in the last part, do this:

Click on your chart with your right mouse button
A pop up menu appears
Move your mouse up to "Format Chart Area"

] ||
Format Chart Area... Igures
w Chark Type...
=
= Source Data. ..
E Chart Options. ..
s i [ |
S Lacakion, ..
o ; ; ;
o 400 600 800 10.00
Chark Window ' ' ' '
Millions
dh Cut o
Copy
e Click on Format Chart Area with your left mouse button
e Adialogue box appears, and looks like the one below:
Format Chart Area EiE3
Patterns Faont | Properties I
Eaonk; Fant skyle: Size:
I.ﬁ.rial IReguIar I_
Abadi MT Condensed Lia -
9
T Arial Black 10
T Arial Marrow ;I 11 ;I
Underline: Color: Background;
IN-:une j I Aukamatic j I.ﬁ.utumatic j
ffects revig
[ strikethrough
I Superscripk AaBhCcyyZiz
™ Subscript
v auto scale
This is a TrueType fonk, The same Font will be used on both wour printer and
wOUr SCREer,

(0] 4 I Cancel |

Select the Font tab strip, and change your settings to match those above: Arial, Regular, Size 8. Click OK
when you're done. Your Chart will look something like the one below:
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o L | L_|
Wiesing Figures

Mational Lattery ] : T ;
% E I I I
E Ground Force ] : : :
E - I I I

o g Dy S5 ] : : : =
o E I I I

Casusatty ] ! : : :
0.00 200 400 5.00 g.00 4000

Million=

| | | |

We now have four programmes showing, and different ones! Not quite there yet, then. We need to move

the chart up a bit, and then resize it.

To move your chart up, do the following:

 Move your mouse into the Chart Area, but on a white bit

e Hold down your left mouse button

o Keep the left mouse button held down, and drag your mouse upwards

e Your chart should move up

e Let go of the left mouse button when your chart is near the top
* Inthe image below, the top left of the chart has been moved to the cell B2

Chart Area 7| =]
A | B ¢ | D E | F | 5 | H ]

1
2 [ | |
= Wieswing Figures
4 Mational Lattery ] ; ; 5
5 @ T T T
g E Ground Force ] . . .
? E 1 I I I

mo5 DY 505 ] : : : -
= o 1 T T T
=) Cazuatty ] : : : :
15‘ 000 200 400 600 800 1000
12 Millions
13 || ||
14

Now that we've moved our Chart up to the top of the spreadsheet, we can resize it.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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Resizing an Excel Chart

To resize your chart, do the following:

Move your mouse pointer to the middle black square on the bottom row (if you can't see any black
squares around your chart, click on the chart with the left mouse button to select it)
Your mouse pointer will change to the shape of a arrow-headed line, like the one in the image below:

Million=

— W

When you mouse pointer changes to the shape above, hold down your left mouse button
Keep your left mouse button held down and drag downwards

Let go of the mouse button when the bottom of your chart reaches about Row 22

Your chart should look like the one in the next picture:

Wieswing Figures

Mational Lottery

Ready Steady Cook

Yicar of Dikley

Ground Force

Halkyy City

Lenny Henry

Programmes

Dy 505

Changing Rooms

Antiques Roadshow

Casualty

ooo 200 400 &S00 J00 1000

Millions

] i ] (e (PR [ |0 A e [
Raf|—= |25 || o |~ | | | = |0 | ra | = | | S B2 | OO e O P

23
[ 4 » M} Sheett f Sheetz } Sheet3 / 12

As you can see, all the programmes are now showing. You can make your chart wider by moving your
mouse over the right middle black square, and then dragging outwards. But careful not to drag too far out
because some of your programmes will disappear. If this happens, click Edit from the menu bar, then click
"Undo" from the menu.

We can make some of the Titles bold. To make your titles bold, do the following:

Click on Viewing Figures, but click with your right mouse button
A small menu pops up
Click on Format Chart Title

Mational Lottery

Another dialogue box pops up
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e Select the Font tab strip

e Choose a Bold font style and click the OK button

e Your title is made Bold

¢ Do the same with the Programmes title and the Millions title

Your Chart should now look something like the one below:

Viewing Figures

Mational Lottery
Ready Steady Cook |
Vicar of Dibley |
Ground Faorce ]
Holby Gity |
Lenny Henry |
DIY 508 |
Changing Rooms |

Programmes

Antigues Roadshow

Casualty |

0.00 200 4.00 B.00 8.00 10.00

Millions

Except you might have noticed something: The programme with the highest viewing figures, Casualty, is at
the bottom! The programme with the lowest viewing figures is at the top. We can do something about this
quite easily. To get them other way around, do this:

e Click on Sheet 1 to return to your spreadsheet Data

e Make sure the data is still highlighted

e Click on Data from the menu bar

e  From the drop down menu, click on Sort

e On the Sort dialogue box, change the two Descending radio buttons to Ascending
e Click the OK button

e  Click back on Sheet 2 to see your Chart

e The Highest programme should now be at the top, and the lowest at the bottom

The above method is not an ideal solution, but that is due to the nature of the Chart type we have chosen.

We'll now do something different with the ITV programmes. We'll create a different chart - a Pie Chart.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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Excel Pie Charts

The next chart we'll create is a pie chart. The process is almost the same, but instead of creating the chart
in a separate sheet, we'll create it in the spreadsheet itself. This time, we'll use the ITV figures.

To make a start on the pie chart, highlight the ITV data in the spreadsheet you created earlier, as in the
image below:

T
Millions

W'ho. . Millionaire 1099
Heartheat 1022
Bad Gitls .42
The Eill B.54
The “ice G.37
Blind Date G.31
otars in their Eyes B.26
Foothaller's Wives B.17
Champions League B.039
Inspector Morse 5.81_

Once the data is highlighted, click on Insert from the menu bar. From the menu, click Chart.
Alternatively, click the Chart icon in the toolbar. The chart icon looks like the one below:

CNC A T
by
| D I Chart '-.-'-.-'izar-:lI F | G

If you can't see that icon in the tool bar, click on View > Toolbars. From the menu that appears, make
sure there is a tick next to Standard.

J Arial -

Whichever method you use, the Chart Wizard will start up again.

In step 1 of the Wizard, locate the word Pie in the Chart Type list. The pie chart sub-types appear just to
the right. There are six sub-types to choose from. Select the first one.
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Chart Wizard - Step 1 of 4 - Chart Type EE3

Standard Twpes | Zustom Twpes I

Chart type: Chart sub-kype:
|_H_ Colurin =]

E Bar
|ﬁ Line
5 Y ric

. XY (Scatter) D
ol | O' Y | &

@ Doughnut

il Radar
|l Surface b
®: Eubble

[ﬁ;ﬁ_ Skock, ;I

ie, Displays the contribution of each value
o & kokal,

Cancel | < Back | Mext = | Einish |

You can click the "Press and Hold to View Sample" button to see what it looks like. But click Next when
you're done.

Step 2 of the Wizard is for the data range to include in the Pie chart. We've already selected our data, so
just click the Next button on Step 2.

Step 3 of the Wizard looks like this:

Chart Wizard - Step 3 of 4 - Chart Options EE
''''''''' Titiss | Legend | DataLabels |
Chart Litle:

Category (1) axis;

Walue () axis:

Second category (2) axis;

Second value () axis;

|
Cancel | < Back | Mext = I Einish |

Click inside the Chart Title text box, and enter the title "Viewing Figures in Millions". Then click the Data
Labels tab strip.

O whe... Millionair:
B Heartbeat

O Ead Girls

O The Eill

B The Wice

o Blind Date

B Etars in their Eyes
O Footballer's Wives
B Champions League

| Insrector bldorss

Under "Data labels", the default value None will be selected. Click "Show value" instead. (But click the
others and see what happens). Then click the Next button at the bottom.

Step 4 of the wizard is where you specify the location for your new chart. This is the dialogue box:
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Chart Wizard - Step 4 of 4 - Chart Location EiE

Place chart:

|.I_I_ " As new sheet: |Chart1

s

i f C oo O
Cancel | < Back. | Mexk = | Einish I

Make sure your dialogue box has "As object in" selected, and it says Sheet 1 (This is where your
spreadsheet should be. If it's in a different sheet, click the black down arrow and select the sheet you
need.)

Next, click the Finish button at the bottom. We'll see what happens inthe next part of this lesson.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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Project Three

Create a Column chart from the new data you created in the previous lesson.
The chart should include chart titles.

The chart should also appear in its own Chart sheet. (Step 4 of the Wizard is where to set this up. Just
make sure "As new Sheet" is selected.)

Your completed project might look something like the one in the link below:

The completed project

The idea behind the chart is to compare one set of values with another.

<-- Back One Page Move on to the Next Section-->

<--Back to the Excel Contents Page
View all our Home Study Computer Courses
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Excel Formulas - The Basic Operators

In this section, we'll discuss formulas some more. Because formulas are at the heart of spreadsheets. The
reason you're using a spreadsheet is to work out some sort of mathematical calculation, whether that be a
family budget calculation or a company profit calculation. And you can't do those calculations without using
formulas.

Adding Up
You've seen how to add up in Excel. You either used individual cells to add up, like this:
=Al + A2 + A3 + A4
Or you have used a range of cells with the Sum function. Like this:
= Sum(Al:A4)

Either way you get the same answer. But you can combine the two to add up. For example, if you wanted
to add up cells Al to A4 and cell A10, you'd do it like this:

= Sum(Al:A4) + A10
You can also use the Sum function alone. Like this:
= Sum(Al:A4, A10)

Here we have entered a range of cells in the brackets - A1:A4. But after that, we added a comma then the
final cell we wanted to add up. If we also wanted to add cells A12 and A14 to our sum, we just add a
comma then the cell reference. Like this:

= Sum(Al:A4, Al10, Al12, Al14)
Try using this Sum function yourself by doing these exercises:
Exercise 1

On a new spreadsheet, enter the number 3 in the following cells: A1, B1, C1, D1. Enter the number 3 in the
cell A2. Use only the Sum function to add up the values in the cells. Display the answer in cell A4. In other
words, the spreadsheet should look like the one below:

14

In the picture above, cell A4 displays the answer. Only a Sum function was used.
Exercise 2

Enter the number 3 in the following cells: A1, B1, C1, D1, E1. Enter the number 3 in the following cells: A3,
C3, E3. Add them all up using a Sum function. Display the answer in cell A5. The spreadsheet will look like
this:
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A | B | ¢ | D | E |
1 3] 3] 3 3] 3
2
3 3 3 3
4
5 24
B

The correct answer, 24, is displayed in cell A5. Only one Sum function was used.

Multiplying

You saw how to multiply two numbers together. Just use the asterisk symbol with the cell references. Like
this:

=Al * A2

But what if you wanted to multiply a long range of values together? You might want to multiply all the
numbers in the cells A1 to A10. Surely you don't have do this = A1 * A2 * A3 * A4 * A5, etc?

You'd be right - you don't have to enter all the cell references. You can do the same as in the Sum
Function, just use A1:A5. But instead of using the word Sum you use the word Product. Like this:

=Product(A1l:A5)

If you look back at Exercise 2, the number 3 was in the cells Al to E1. We then added them up. If you
wanted to multiply them all instead, use Product. To further illustrate what Product does, this is what we
wanted to multiply:

=3*3*3*3*3

So 3times 3 = 9. Multiply the 9 by the third 3 to give 27. Multiply the 27 by the fourth 3 to give 81. Multiply
the 81 by the fifth 3 to give 243. And that's what Product does: Multiplies a range of cells together. Just like
the Sum function, you can add other cells after a comma. Like this:

= Product(Al:E1, A3)
In the above function, our answer of 243 will be multiplied by whatever is in cell A3.
Try using Product yourself with these exercises:
Exercise 3

In the cells Al to E1 enter the following values: 1, 2, 3, 4, 5. Use Product to multiply them all together.
Display your answer in cell A3. So your spreadsheet will ook like this:

e =
T2 31 4 A

120

Exercise 4

In the cells Al to E1 enter the following values: 1, 2, 3, 4, 5. In the cells A3, C3 and E3 enter the following
values: 6, 7, 8. Use Product to multiply all the values together. Display the answer in cell A5. Your
spreadsheet will look like this one:
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A | B | ¢ | D | E |
1 1] 2] 3] 4 5
2
3 5 i 8
4
5| 40320
B

Subtraction

To subtract one value from another, you just use the minus sign in between your cell references. Like this:
=Al - A2
Below is an image from a spreadsheet showing a subtraction formula:
A3 | Bl =1 - B

A | B | © | D
25 14

111
L ]

o |l | O | —

Cell A3 is where the answer is displayed, and where we entered the formula.
If you want to subtract more than two cells you can do it like this:
=Al-Bl1l-C1

Subtraction is fairly straightforward in spreadsheets, and shouldn't cause you too many problems.

Division
If you want to divide one number by another the symbol to use is this one:
/

That's the forward slash, and can be found just to the right of the full stop on your keyboard. You use it like
this:

=Al/C1

There are a number of times when you would want to divide, but wouldn't need the divider symbol at all.
For example, you use division to calculate Averages, but you wouldn't need the divider symbol here
because Excel has a separate Average function. Likewise, if you wanted to calculate monthly payments,
you wouldn't need to use the divider symbol because Excel had quite a number of financial functions you
can use. (We'll meet some of these later in the course.)

In the next part, we'll take a look at how to combine these basic Math operators in Excel.

Move on to the Next Part -->

<--Back to the Excel Contents Page
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Excel Formulas - Combining the
Mathematical Operators

There are times when you will want to combine the arithmetic operators in your
calculations. Here are a few examples of combining the operators:

Example 1

e  Start a new spreadsheet

e Enter the number 25 in cell Al

e  Enter the number 50 in cell A2

e Enter the number 2 in cell A3

e In cell A5 enter the following formula

=(Al + A2) * A3

Press the Return key on your keyboard to get the answer

The answer you should have got was 150. Notice the brackets in the formula. The
brackets group part of your sum together. Without them, Excel will normally calculate
from left to right. But it does some calculation before others. Excel sees multiplication
as more important than adding up. To see what happens without the brackets, do
this:

e Click oncell A5

e  Click inside the formula bar at the top

e Delete both the brackets from the formula

e Press the return key on your keyboard to see the answer

Now the answer is different! This time you should have gotten 125. Here are the
picture versions of both formulas:

You might think the second one is wrong. But it's not. It's just the way Excel works
things out. Because it sees multiplication as more important than adding up, it will
multiply cell A2 by cell A3 first. That gets the answer of 100. Excel will then add this
answer to cell A1, which gives the answer 125.

With the brackets in, you force Excel to work things out your way. You're saying "Do
the sum in brackets first, then multiply”. When you do the brackets first, you get a
different answer. A1 + A2 = 75. Multiply 75 by cell A3 and you get the answer 150.

The moral is: take care when you are grouping operators together. And force Excel
to work things out your way by using brackets to group your sums.

Example 2

Substitute the asterisk symbol from example 1 with the forward slash. So the formula
will be changed from this:

= (Al + A2) * A3

to this:

= (AL + A2) | A3
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Press the Return key on your keyboard to reveal the answer. It should be 37.5. Now
take the brackets out and try again. Again, you get a different answer. The total will
now be 50!

Again the same process is at work. Excel sees division as more important than
adding up, so it does that first. So it will divide 50 by 2 to get 25. Then it will add the
contents of cell Al to get 50. With the brackets, we force Excel to do the adding up
first, then divide by the cell A3.

Example 3
This time, enter the following formula for cell A5:
= (A1 * A2) / A3
Press the Return key on your keyboard to reveal the answer. It should be 625.

Remove the brackets and try again. The answer should be 625 again. This is
because Excel sees Multiplication and division as being of equal importance. When
all things are equal, Excel calculates from left to right.

Likewise, Excel sees addition and subtraction as being of equal importance. So it will
calculate from left to right if you use addition and subtraction in the same formula. As
an example, study this formula below:

A5 hd =| =A1 +AZ - A3
S ER e E
1 25
2 &0
3 2
4
5 73l
L ]
B

As you can see, the formula in cell A5 is = A1 + A2 - A3. Now does that mean this:
= (Al + A2) - A3

Or this:
= Al + (A2 - A3)

Work it out on paper to see if there is any difference.

Despite the answer above, operator precedence is important: All sums are not equal!

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
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Project Four - A Budget spreadsheet

OK, let’s put all our arithmetical operator knowledge together and construct a spreadsheet.
The spreadsheet you're going to construct is a Budget spreadsheet. Here’s the scenario.

There is a small town called Evercrease. Last year the council had a budget of half a million pounds to
spend. They overspent by 69 thousand pounds, which the citizens of Evercrease objected to most strongly.
So strongly in fact that they got rid of the entire council. Now they need to appoint somebody else to
manage the budget. They have asked you to do the job. Have a look at last year’s budget:

Budget Spreadsheet Image (opens in a new window - 165K).

The final budget figure is in cell B33 and reads minus £69 000. Your job is to make a new budget
spreadsheet, ensuring that you do not have a minus figure in cell B33.

Your first job is to recreate the budget spreadsheet exactly as it is in the picture. Once you have a
spreadsheet exactly like the one in the image, along with the formulas to get the same figures, you can
start to enter your own numbers. For example, the budget shows that there are 5 teachers. The teachers
are paid 16 thousand pounds a year. These 5 cost 80 thousand pounds a year to keep. Perhaps you don't
need 5? Change the number to 4. When you change it to 4, the 80 thousand total should adjust. That's
because you will have entered a formula in the total column.

So once all your formulas are place, you can adjust the figures in the Number column, column D in the
spreadsheet. What you change the numbers to is entirely your decision. After all, you are in charge of the
budget. It's your job on the line!

But there are some things you can try. These are:

Division formula
Subtraction formula
Multiplication formula
Addition formula
Combination formulas

You can put the combination formulas in cells B37 and B38 (New Final Budget and New Monthly
Spending). Your combination formulas will be the ones with brackets. Something like =A1 - (A2 + A3) or
=(Al + A2)/12.

Concentrate first on reproducing the same spreadsheet as in the image, and getting the same totals as
that one. When your spreadsheet is the same as that one, then you can play around with the numbers.

There is a lot of work to do in the spreadsheet, but it will give you good practice entering text and formulas
on a large spreadsheet.

Remember, though: the people of Evercrease are looking for a budget that is less than half a million! If your

budget is over that figure, they’ll fire you!

Good luck.

NOTE: If you would like a version of the budget with all the formulas already entered, click here: The
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Budget as an Excel Spreadsheet.

<-- Back One Page Move on to the Next Part -->

<--Back to the Excel Contents Page
View all our Home Study Computer Courses
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The Average Function in Excel

In section 6, we're going to look at some slightly more complex formulas than the simple operators. In fact
the formulas in this section are not really formulas at all. They are Functions. Don't be put off by the name.
A Function is just something to help you calculate. You've already met the SUM() function. The ones in this
section are just some more of the functions built in to Excel. We will explore averages, date and time
formulas, and one or two financial formulas. It might get a bit tricky, so hold on to your hats!

Averages

We'll make a start with averages. First, what is in an average? In maths, an average is a number derived
by dividing how many there are in a list by the list total. For example, suppose a list of student scores in an
exam was this: 9, 7, 6, 7, 8, 4, 3, 9. We only have eight scores. To get the average score we first need to
get the total. So add up the numbers inthelist: 9+ 7+ 6+ 7 + 8+ 4 + 3+ 9 =53. Next divide by how many
there are in the list: 8. So to get the average score the sum is 53 divided by 8. The answer is 6.625. Which
means that the average score in the exam was 6.625.

Once we have an average figure we can see at a glance which students are performing above average,
and which below. Clearly, the poor student who scored only 3 needs some extra homework!

So now that you know what an average is, how do you calculate averages with Excel? Well, start a new
spreadsheet and enter those exams scores in cells Al to A8. Your spreadsheet will look like the one
below:

LOu RS R =N R B w3 i R A

e Next, click in cell A9
¢ We now need to insert the average Function

There are a couple of ways to insert a function.
Method 1

Click on the equals sign next to the formula bar. This is the Edit formula button, and can be seen in the
picture below:
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A FHE =
A | B |[Wwe T D
Edit Formula

1 9
2 7
3 5
4 7
5 g
5] 4
7 3
g 9
9 |

| ]
10

When you click the equals button, you'll see a palette appear just under the Name box and Formula bar. It
will look like the one below:

SN =X J= =

Forraula result = Ok Cancel
2 7

3 G

4 7

a a

B 4

7 3

a 9

9 |- |

10

There are one or two things to notice about the Formula palette. First look in cell A9. There is an equals
sign in it. Excel has entered this because all formulas and functions must start with this symbol, and it
knows that it's easy to forget to put an equals sign in. So it does it for you.

The next thing to notice is that the Name box says "Sum". There is a black down-pointing arrow to the right
of "Sum®. Clicking on the arrow will reveal a list of Functions.

UM | ;d X /=] =

T
iﬂr:R.ﬁ.GE el -k |
SUMPRODLICT
IF
HYPERLIMK
COUNT
M
SIN
SUMIF
PMT

Mare Functions. ..
[T

Zancel |

The one we want is there. So click on Average with your left mouse button. The palette changes to this
rather complicated one:
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| avErAcE | =] X [ =] =AVERAGE{A1:A8)
AYERAGE
Number1 |STEIE ™| - (5;7;6;7;5;4;3;9}
Mumnber2 I :kJ =

= 6,625
Returns the average (arithmetic mean) of its arguments, which can be numbers or names,
arrays, or references that contain numbers,
Mumber1: numberl,numberz, ... are 1 ko 30 numeric arquments Far which yau want
the average.

Faormula result =6&,625 Ok I Cancel I

L=

Excel does a few things here: shows you what Function it is putting in the Formula bar at the top
(=Average(A1:A8); gives you a list of the values in your cells (in brackets after the Numberl text area);
gives you the result (at the bottom "Formula result = ").

But don't worry if you're scratching your head over that dialogue box. Just click the OK button at the
bottom. The palette closes, and Excel inserts the result of the average in cell A9.

Method 2
The second way to enter a Function is this:

e Click inside cell A9

e« From the menu bar at the top, click on Insert
e  From the drop down menu, click on Function
e The following dialogue box appears:

Paste Function EH
Function categary: Function name:

Most Recetly Lsed - _

05

Financial ACOSH

Dake & Time AddBackslashToParens

Math & Trig ADDRESS

Skatistical AND

Lookup & Reference AREAS

Database ASIM

Texk L] |AsIMH

Logical ATAMN

Information =] |aTanz d|
ABS{number)

Returns the absolute value of a number, a number without its sign,

()4 I Zancel |

This dialogue box is a listing of all the Functions built in to Excel. The Average function is under Statistical.

¢ Inthe Function category section, click on Statistical with your left mouse button
o Alist of all the Statistical functions appears on the right hand side

e Locate Average and click it with your left mouse button

e Click the OK button at the bottom

e The function palette appears, the same one from Method 1

¢  Click the OK button and Excel will insert the answer to your Average Function in cell A9

But what if Excel has the wrong cell references for your Average? Is there any way you can edit the
Functions? Yes, there is. Try this:
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Click in cell B9 of your spreadsheet. Use one of the methods outlined to bring up the formula palette. Your
spreadsheet will now look like this:

avERaGE | =]/ /[ =| =AVERAGE(A9)
AVERAGE

Number1 | TR, ~: | - - .25
Mumberz I :RJ =

= 6,625
Returns the average (arithmetic mean) of its arguments, which can be numbers or names,
arrays, of references that contain numbers,

Mumber1: numberl,numberZ, ... are 1 to 30 numetic arguments For which wou want
the average,

Forrnula result =6.625 8] 4 I Cancel |

This time the formula bar just reads =Average(A9). You can edit the function by clicking inside the
formula bar at the top. Change A9 to A1:A8 and the click the OK button.

Of course, you don't need to use the formula palette at all. You could just enter the Function directly, just
like you did with the Sum() function, or any other formula: click on the cell where you want the answer to
appear. Then click inside the formula bar. Enter =Average(A1:A9) and press the return key on your
keyboard.

The advantage of using the formula palette is that Excel enters the correct function for you. It's very easy to
make a typing error if you do it yourself, and then get an enigmatic error message for your troubles.

OK, time for an exercise.

Exercise

A dart's player is trying to work out his three dart average, and his one dart average. Help him out. His
scores for a single game were these:

60
55
24
95
100
60
86
21

So his score of 60 was achieved by throwing three darts. Likewise, a total of 55 was achieved with three
darts. In fact, every score on the list is a the result of three darts. Your task is to work out his three dart
average.

Once you have worked out his three dart average, let him know what his average score was for one dart.
(You don't need the Average Function here. What you are working out is how many darts he threw in total.
Then divide the grand total for all his darts by this number. An easier way to get the answer is to divide the
Average by ... ?)

In the next part, we'll take a look at Date and Time functions in Excel.

Explore Date and Time functions in Excel -->
<--Back to the Excel Contents Page
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How to use the Date Functions in Excel

There are a numbers of different reasons why you would want a Date or Time function in a spreadsheet: If
you're running your own company, you might want to record when an order was received and when it was
processed. You could then calculate the difference between the two, so that you check how fast the orders
were being processed. We'll do that now.

Date Functions

Set up this simple spreadsheet in Excel

A3~ =
A | B | ¢ |
1 | Date Order Taken Date Order Sent Time Taken
2
3 |
o
4
g

Click inside cell A3. To enter a date Function, do the following:

e Click on Insert from the menu bar

¢  From the drop down menu, click on Function

¢ The Paste Function dialogue box appears

* Inthe Function category section, click on Date & Time
¢ Inthe Function name section, click on Date

¢ Click the OK button at the bottom

e The formula palette appears on your spreadsheet

| pate|=|/X [=] =DATE(
ATE

Year || :k_l =
Month I :kJ _
Day | ==

Returns the number that represents the date in Microsoft Excel date-time code.

Year is a number From 1900 ko 9232 in Microsoft Excel For Windows or From
1904 ko 9999 in Microsoft Excel for the Macinkosh,

Farmula result = k. I Cancel

What Excel wants you to do here is to enter some figures for the date. So:

e Click inside the Year box and enter 2002

¢ Click inside the Month box and enter the number 4 (The fourth month - April. Or you can enter any
number you like here, the number for the current month, if you want)

e Click inside the Day box and enter the number 15 (The 15th day - or enter another number, if you
want.)

¢  Click the OK button at the bottom

e Excel enters the Date in cell A3
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A3 | =| =DATE(2002 4,15

A I B |

C

4151
L ]

el | b —

Notice how the date Function is set out in the Formula box. It is set out as =Date(2002, 4, 15).
However, in cell A3 the date is 4/15. It has missed out the year completely! Is there anything we can do to

resolve the matter?

The reason Excel has missed the year out is because of the way cell A3 was formatted. To change the
formatting of cell A3 (or any cell), click on Format form the menu bar. From the drop down menu, click on
Cells. The format dialogue box appears. Click the Number tab strip at the top. Under Category, click on
Date. A list of different date types appears in the Type list. The following picture shows this:

Date Order Taken Date Order Sent Time Taken

Format Cells
I"-.Iuml:uerl Alignment | Fant: | Border | Patterns | F‘ru:uteu:tiu:unl
Category: —Sample
General ] 415
Murnber
Currency Twpe:
.ﬁ.ccuuntini
" 3/14/98
Tirne 03/14/98
Percentage 14-Mar
Fraction 14-Mar-95
Scientific 14-Mar-08
el L =
March-95 hal
Cuskom ﬂ

Date Formats display date and time serial numbers as date values, Use Time

formats to display just the time porkion,

o |

Zancel

The Type section of the dialogue box is where you set how you want your date to look. At the moment,
the first option is selected 3/14. Scroll down and click on March 14, 1998. Then click the OK button at the

bottom. Your spreadsheet will now look like this one:

A3 =] | =DATE(2002 4,15)

A I B |

C

April 15, 2002 !

| e il | B0 | —

In cell B3, for the Date Order Sent, enter another Date Function. This time, have the date read May 3,

2002. Your spreadsheet will then look like this:

Date Order Taken Date Order Sent Time Taken
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In cell C3, under Time Taken, we'll work out how long the order took to be sent out.

The Days360 Function in Excel

The Function to use when you want to work out how many days difference there are between two dates is
the Date360( ) function. So click on cell C3 and do the following:

e  From the menu bar, click on Insert

e  From the drop down list, click on Function

e The Paste Function dialogue box appears

¢ Under Function category, click on Date & Time
e Under Function name, click on Days360( )

¢ Click the OK button at the bottom

e The formula palette appears on your spreadsheet:

pavssed | =] X [ =] =DAYS360(
AYSIED

Start_date || :k_l =
End_date I :-;J =
Method I :-;J =

Returns the number of davs bebween bwo dates based on a 360-day vear (bwelve 30-day
monkhs).
Start_date start_date and end_date are the bwo dates between which you want to
knows the number af days,

Farmula result = k. I Cancel |

What Excel is looking for here is two dates: a start date and an end date. Our start date was in cell A3, and
we can just enter the cell reference here. So click inside the Start_date box and enter A3. Next, click
inside the End_date box and enter B3. Click inside the Method box and enter True (This will ensure that
Excel calculates from the European date system.) Click the OK button when you're done. Your
spreadsheet might look like the one below:

C3 | =| =DAYS360(A3 B3 TRUE)
A | B | C |
Date Order Taken Date Order Sent Time Taken

April 15, 2002 May3,2002 [Rrereeesse]

| b |G | D —

If your spreadsheet has all of those hash symbols in cell C3 it means that your column is not wide enough.
So widen the C column until it takes all the date. Your spreadsheet might then look like this one:

C3 =] = | =DAY S360(43,B3, TRUE)
A | B | C |
1 Date Order Taken Date Order Sent Time Taken
2
3 April 15, 2002 May 3,2002 | January 18, 19EIEI!
4

As you can see, something has clearly gone wrong. Cell C3 reads January 18, 1900. The reason it is
showing such a bizarre answer is because of the way the cell is formatted. We have C3 formatted as a
date. But the answer to our Days360( ) function is not a date. The answer is a number. So we need to
reformat that cell.
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Format the cell C3 so that it is a number, and set the Decimal places to zero. Your spreadsheet will then

show the correct answer, like the one below:

A B |

C3 | =| =DAYS360(A3 B3 TRUE)
|

C | 0 |

Date Order Taken Date Order Sent

Time Taken

April 14, 2002

May 3, 2002 |

13 |

M| el | 0| —

Entering dates can be fairly straightforward, like cells A3 and B3. But performing calculations with dates
can be slightly more complex. To get you some more practice, try this exercise.

Exercise

The Mayor or Evercrease celebrates his official birthday on the 28th of June (Nobody knows his unofficial
one). Work out how many days there are left to the Mayors official birthday party. After all, you are invited,

S0 you need to start saving for his present.

To get the current date, you can use this function: =Now( ). You can then format the cell to get the date

format you prefer.

In the next part, we'll take a look at the Time Function.

Explore the Time Function in Excel -->

<--Back to the Excel Contents Page
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How to use the Time Function in Excel

Getting the time into a spreadsheet cell is fairly straightforward. First, use the Now() Function. Then format
the cell to the Time format you want. We'll go through it now. To enter the Time function, do the following:

e Click on any empty cell
¢  Click inside the formula bar
e Type in this formula:

=Now( )
e Pressthe Return key on your keyboard
When you press the Return key, Excel will give the current date and time. To get only the time, do this:

e Click inside the cell where your Now( ) function is.

From the Excel menu bar, click on Format

From the drop down menu, click on Cells

The Format Cells dialogue box appears. Click the Number tab strip
Under Category, click on Time

Under Type, select the Time type you want.

Click OK when you have finished

The thing to bear in mind about the Time function is that Excel doesn't update it every second. So you can't
use it like a normal clock. But Excel will update the Time when you enter a calculation. As an example, try

this:

¢ Note the cell where your Time function is, and what time it reads

e Click inside an empty cell

e Enter any calculation (= 2 + 2 will do)

e Pressthe Return key on your keyboard

e Look at your Time function cell again. Excel will have updated the Time

You don't have to use the Now( ) function to get the Time. We'll see how to get the Time another way, and

we'll construct a timetable.

A Timetable

Start on a new spreadsheet, and create the same labels as the ones in the image below:

A I B I C |
Joh Start Time Time it Takes

Wash Pots
Hoover
Rest

Dust
Windows
Rest

OO0 00|~ | M e | LD D —

What we're going to do is enter a start time of 9 in the morning. That's when we start washing the pots.
We'll estimate how long it takes to wash the pots in the C column, under "Time it Takes". We'll add the
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"Time it Takes" to the "Start Time" to get a new start time for the Hoovering . But you'll see how it works as
we go along.

The first task is to format the Start Time column. So:

Highlight the Start Time column, from B3 to B8.
From the Excel menu bar, click on Format
From the drop down list, click on Cells

The Format Cells dialogue box appears
Click the Number tab strip, and select Time
Under Type, select 13.30. Then ckick OK

The next thing to do is enter a time for cell B3, the Start time. Now that you have formatted the B column as
a Time, you can go ahead and just enter a time. Do this:

Click on cell B3

Click inside the formula bar

Type in 09:00 (the colon in between the numbers is important)
Press the return key on your keyboard

Excel will now treat cell B3 as atime - 9 AM

We'll assume that we're very fast at washing pots (it's all that practice!). So we'll spend just 15 minutes on
this job.

Click inside cell C3

Click inside the formula bar

Type in 0:15

Press the return key on your keyboard

Excel will probably enter 00:15 for you. (The first two zeros are for the hour.) Your spreadsheet will now
look like this:

A | B | C [ 0 |
Joh Start Time Time it Takes

Wash Pots 09:00f o0- 1 5!
Hoover

Rest

Dust

Windows

Rest

We now need to add 15 minutes to the starting time of 9 AM. So do the following::

Click inside cell B4
Then click inside the formula bar
Enter this formula:

=B3 +C3

Press the return key on your keyboard
Excel will enter 09:15 in cell B4

OK, we have a start time for the hovering - 9:15 in the morning. We can get Excel to Auto Fill the rest of
the formulas, because they'll be same. So:

Click inside cell B4
Move your cursor to the bottom right of the cell
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When your cursor changes to the shape of a black cross, hold down your left mouse button.
e Keep it held down and drag the mouse pointer to cell B9
o  Excel will enter 09:15 for all the cells

The only thing left for us to do now is enter some times for the "Time Taken" column.

e Clickoncell C4

¢ Click inside the formula bar and type in 01:00 (meaning one hour for the hovering)
e Press the return key on your keyboard

e  Excel will change all the cells from Rest downwards to 10:15

e Your spreadsheet will now look like this one:

C4 | =| 01:00:00
A | E | C | O

1 Joh Start Time Time it Takes
2
3 |Wash Pots 09:00 00:15
4 |Hoover 09:15{ EI1:EIEI!
5 |Rest 10:15
E |Dust 10:15
7 |(Windows 10:15
g |Rest 10:15
g 10:15
10

OK, you can enter all the other figures yourself. Enter these figures in the remaining "Time it Takes"
column:

Rest: 30 minutes
Dust: 30 minutes
Windows: One hour
Rest 30 minutes

When you are finished, you should have a timetable like the one below:

A | B | & I

1 Joh Start Time  Time it Takes
2

_ 3 |Wash Pots 09:00 oo: 15
_4 |Hoover 03:15 01:00
5 |Rest 10:15 00:30
6B |Dust 10:45 00:30
7 |Windows 11:15 01:00
8 |Rest 1215 0030
=D 12:45

10

And that's how to construct a simple timetable. Working with times can be quite tricky, and a good
knowledge of Excel functions will stand you in good stead. But we'll leave the Time function, and move on
to something else

We'll now move on to some financial formulas.

Explore Financial Functions in Excel -->

<--Back to the Excel Contents Page
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How to Work out Interest Rates in Excel

The financial function we're going to explore will calculate the monthly payment amounts on a loan. The
function we're going to use is PMT( ).

The PMT () Function

If you want to know how much a loan will cost you, then the PMT () function is ideal. How much will | have to
pay back if | borrow a thousand pounds over 2 years? Over 5 years? Over 10 years? You can calculate this
with the PMT () function.

The PMT( ) function expects certain values in between those two brackets. The values are known as
arguments. The arguments that the PMT( ) function expects are these:

PMT(rate, nper, pv, fv, type)

The last two, fv and type, are optional. If all this sounds very confusing, then don't worry: we'll clear it up with
an example.

The example is this: You want to borrow ten thousand pounds from your friendly banker. You also want to pay
it back over 5 years. What you need to know is - how much will this loan cost me every month?

We'll work it out with the PMT( ) function. First, create a new spreadsheet like the one below:

A | B | G | D | E
Loan amount: 10000

Interest Rate Number of Payments  Present Value  Monthly Amount Total Paid Back

[ [N S TR

The figure in cell B1 is the amount we want to borrow - ten thousand pounds. Our financial function PMT( ) will
go under Monthly Amount, in cell D4.

Before we can enter our function, we need to work out the Interest Rate, the Number of Payments, and the
Present value. These are the arguments for our function. Let's start with the Interest Rate, the first of our
arguments (rate).

The bank tells us that the interest rate is 12 percent. This is for the entire year. As we want to know how much
to pay back each month, we need to divide this figure by 12 (12 months in a year; divide this into 12 percent).
Of course, this is a simple division: 12 divided by 12 is 1. But we'll let Excel work it out. So do the following:

. Click inside cell A4
Click inside the formula bar
Enter the following formula:

=12% /12

The press the return key on your keyboard
Excel will enter 0.01 in cell A4

The next thing we need to work out is how many payments there are in total. We are paying back the loan
every month for 5 years. As there are 12 months in a year, the formula is just 12 multiplied by 5. So do this:

. Click inside cell B4
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Click inside the formula bar
e Enter the following formula:
=12 *5

e  Press the Return key on your keyboard
e  Excel will enter 60 in cell B4

OK, we have now worked out the second argument for our PMT( ) function - the nper bit. We can now move
on to the pv part of the argument, or Present Value. The Present Value is sometimes known as the Principal.
It is what the loan is worth now, and not say 5 years into the future. In other words, it's ten thousand pounds
for us. So for the Present Value column in your spreadsheet, do this:

. Click inside cell C4
e Click inside the formula bar
. Enter this:

=B1

e Press the return key on your keyboard
e  Excel will enter 10000 in cell C4, because this is the figure you entered into cell B1

Your spreadsheet should now look like the one below:

A | B | B | D | E |
Loan amount: 10000

Interest Rate Number of Payments Present Yalue  Monthly Amount Total Paid Back
0.0 B0 10000

O 7| b L0 B —

Time now to enter our PMT( ) function in cell D4. So, do the following:

o Click inside cell D4
. Click inside the formula bar
e Enter the following function:

=PMT(A4, B4, C4)

e Press the return key on your keyboard

Excel should now have entered the monthly payments in cell D4. It is usually in red, and with a minus sign at
the start (minus because it's what you owe to the bank). The answer you should have in D4 is -£222.44.

So we have to pay back to the bank every month two hundred and twenty two pounds forty four pence.

The final column is "Total Paid Back". To work out that answer you need to multiply the monthly payments by
the number of payments. Which should cause you no problems at all. When you're done, the final spreadsheet
looks like this:

A | B | 5 | D | E
Loan amount: 10000

Interest Rate MNumber of Payments Present Yalue Monthly Amount Total Paid Back
0.01 B0 10000 -E222.44 -£13,346.57

0 Mm =W k=
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Varying the Interest Rate

We'll now change that spreadsheet slightly. What we'll do is vary the number of payments. At the moment,
we're saying 12 * 5 for the number of payments. But what if we decide we want to pay it back over ten years?
How much are the monthly payments then? And how much do we pay back in total?

We also want to vary that interest rate. There is plenty of competition for loans. What if we can get a better
deal for our interest payments? How does it effect the monthly payments if the interest rate is 11 percent?

We can make only a few slight changes to the spreadsheet to answer these questions.

Insert two more rows into your spreadsheet, and add two labels. Your spreadsheet sheet match the one
below:

A | B i & | D ' E |
Loan amount: 10000
Num of Years
Interest

u'_n|4a-|r_u|r\_1|—x

Interest Rate  Number of Payments Present Value  Monthly Amount Total Paid Back
To get the interest rate, we entered a formula. We entered this:
=12 %/ 12

If we put the percentage figure in a cell of its own, we could then reference that cell in our formula. We could
just put this:

=B3/12

Then we could vary the interest rate by changing the number in cell B3. To clear any confusion, do the
following:

e Click inside cell B3

e Click inside the formula bar

e Typein=12 %

e  Press the Return key on your keyboard

e Click back inside cell B3 because we need to format the cell as a percentage
e To format the cell as a percentage, click Format from the menu bar

e  From the drop down menu, click on Cells. The Format Cells dialogue box appears
e Select the Number tab strip

 Under Category, click on Percentage.

e Click the OK button when you are done

e Cell B3 should now read 12.00 %

You can now change the formula for your interest rate. So click inside the cell where you interest rate is,
probably cell A6. Click inside the formula bar. Change the formula from this:

=12 %/ 12
to this:
=B3/12

When you press the Return key on your keyboard, all of your monthly payment terms should stay the same.
The difference is that you can now alter the interest rate from cell B3. Test it out. Change the interest to 10
percent and see what happens to your Monthly Amount figure.

Exercise
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The Number of Payments formula currently reads = 12 * 5. Change this formula so that number of years is
coming from cell B2.

When you're finished, you final spreadsheet will look like this one:

A | B | E | D E
Loan amount: 10000
Num of Years 5
Interest 10.00%

Interest Rate  Number of Payments Present Value  Monthly Amount Total Paid Back
0.0058333333 B0 10000 SE22.47 -£12 748,23

Play about with the figures in cells B1 to B3 and watch the D6 and E6 figures change. What about a ten year
loan with interest of 15 percent?

PMT extra

You can use the PMT( ) function to work out your savings. You might want to know how much you'll have to
put away in the bank if you want to save 2 thousand pounds in one year. Remember the full PMT( ) function?
It was this:

PMT(rate, nper, pv, fv, type)

To work out how much you'll have to save each month, you need that fv part. The fv stands for Future Value.
You would then use the function like this (assume that the interest rate is a massive 10 percent):

= PMT(10% /12, 12 * 1, O, 2000)

The zero is for the pv part. The pv was Present Value. Because you haven't saved anything yet, the present
value of your savings is zero. The 2000 is how much you want to save over 1 year

In the next part, we'll take a look at how to use IF Statements in your spreadsheets. This is known as
Conditional Logic.

Move on to If Statements in Excel -->

<--Back to the Excel Contents Page
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Using If Statements in Excel

Conditional logic(IF) is used quite frequently in modern spreadsheets. But let's start by asking What is
Conditional Logic?

Conditional Logic

For our purposes, conditional logic is two words - "IF" and "Then". You use conditional logic all the time in
your daily life, without realising it. You might say to yourself, "IF | eat this delicious cream cake THEN my
diet will be ruined."” You're using conditional logic to make a decision: IF | do this THEN that will happen.
Some more examples:

IF | buy this lovely coat THEN I will look beautiful
IF | watch one programme THEN | can tape the other
IF | win the lottery THEN | will be happy

Those are all example of conditional logic. Excel also uses the IF word for conditional logic. You can test
what is in a cell, and say what should happen if it is one value rather than another. For example, suppose
cell Al has the number 6 in it. In cell A2, you can enter an IF function to test whether cell Al is above 5 or
below 5. IF itis above 5 THEN one thing happens; IF it is below 5 THEN another thing happens.

The correct format to use for the IF function is this:
IF( logical_test, value_if true, value_if false)

So the IF function takes three arguments: logical test, value if true, value if false. Let's break
those three arguments down a little more:

Logical Test:
This is what you want to test for. In our example, we wanted to test whether cell Al is greater than or
less than 5. Excel uses this symbol > for greater than and this symbol < for less than. So for the first
argument, we would put A1 > 5

Value If True:
This is the THEN part of the IF statement. Excel needs to know what you want to happen IF your
condition is met. You can put in text surrounded by quotes, or another formula.

Value If False:
You also need to say what should happen IF your condition is not met.

Let's clarify all this with a spreadsheet example. So, start a new spreadsheet and do the following:

e Click inside cell A1 and enter the number 6

e  Press the return key on your keyboard

e Widen the B column of your spreadsheet. Make it nice and big.
e Clickinside cell B1

¢ Click inside the formula bar

e  Enter the following formula:

=IF(Al > 5, "Greater than Five", "Less than Five")

e Press the return key on your keyboard
e Your spreadsheet should look like this one below:
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B1 j =| =IF(A1 = 5, "Greater than 5", "Less than Five"
B c | o | E | F |
6 Greater than 5

o | L0 | -

It's important you get all the syntax right in your IF function. In other words, don't forget the commas, and
the double quote marks around text.

But click inside cell A1 and change the number 6 to the number 4. Then press the return key on your
keyboard. Excel should put Less than Five in cell B1. Now put the number 5 in cell A1 and see what
happens.

Nothing happened, right? That's because the IF function is very precise. You didn't tell Excel what to do if
the number equalled 5.

To get round this, we can use the Greater Than ( >) symbol and the Equal symbol together. Like this:
Al >=5
That says "Al greater than or equal to 5". When we amend our function, it looks like this:
=IF(Al >= 5, "Greater than or Equal to Five", "Less than Five")
You can also test to see if something is Less Than ( <) or Equal to. You could use this for the formula:
=IF(Al <=5, "Less than or Equal to Five", "Greater than Five")
You can even test for Not Equal To. Just join the Less Than (<) symbol to the Greater Than (<) symbol.
Like this:
=IF( Al <> 5, "Not 5", "Is 5")

So to sum up: after typing IF you tell Excel what you want to test for. Then you say what should happen if
the condition is true. Then you say what should happen if the condition is false.

In the next part, we'll take a look at Conditional Formatting.
Explore Conditional Formatting -->
<--Back to the Excel Contents Page
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Conditional Formatting in Excel

If statements in spreadsheets can be very long and complicated. Consider this problem. You have a spreadsheet
of student exam marks. Suppose you want to add the grades as well. If the student scored above 80 it's an A; if
the student scored between 60 and 79, it's a B; if the student scored between 45 and 59, it's a C; if the student
scored between 30 and 44, it's a D; and if the student scored less than 30, it's Fail. The question is, what does
your IF statement look like?

Well, it might look like this:
=IF(B2>=80, "A", IF(B2>=60, "B", IF(B2>=45, "C", IF(B2 >=30, "D", "Fail"))))

What the IF statement is doing is nesting another IF statement on the False condition. So it says, "If B2 is
greater than or equal to 80 THEN put an A in cell B15; if it's not, execute another IF statement.”

But don't worry if that long IF statement is making your brain hurt - it is quite complicated!

However, we'll use that long IF statement to explore Conditional Formatting. You'll be glad to know that there is a
spreadsheet already prepared for you, for this lesson. So right click the link below and save the spreadsheet to
your own computer.

Download the Spreadsheet for this lesson

Open up the spreadsheet you've just downloaded, and take a look at it. It should be this one:

B15 | =| =IF{B2==80,"A" IF(B2==50,"B" IF(B2==45"C", IF(B2 »>=30, "D", "Fail"})))
A, | B | ¢ | o | E | F | &6 | H | 1 |
Steven Many Anne Raymond Mark Paul Eliza Kelly
Maths 7B 89 43 48 a1 76 a7 56
English ] 85 73 51 47 a7 91 73
Science 2] 82 39 fa 52 B4 a7 45
History 45 9 56 72 49 ] 78 o6
Geography a1 24 a4 B4 47 B4 &7 B7
Art 43 B3 49 B2 39 a9 B4 B3
Computer Studies 63 95 45 53 41 a2z g9 o2
French ] N B5 26 2a a1 92 56

REE DD S E G DD 9 W@ 0 0w =

Overall Average 541 85.0 53.6 56.3 443 2.5 8.1 58.5
Steven Many Anne Raymond Mark Paul Eliza Helly
Maths I =] _l A D C C B A, C
English C A, B B C A, A, B
Science B A D C C B C C
History C A C =] c c =] C
Geography C A C B C B B B
Art D B C B D A, B B
Computer Studies B A C C ] A A C
French D A, B Fail Fail c A, C

It looks a bit hard to follow at the moment. It's difficult to know what the data is supposed to represent.
Conditional formatting will help to clarify things.

Conditional Formatting

We can use Conditional logic, however, to format the spreadsheet. What we'll do is to colour those Overall
Averages depending on the grade. One colour will represent a high grade, a second colour will mean an average
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grade, and a third colour will mean a low grade. So let's get started.

e  With your Spreadsheet open, Highlight the cells with Overall Averages in them (From B12 to 112)
o With the cells highlighted, click on Format form the menu bar

e  From the drop down menu, click on Conditional Formatting

e Adialogue box appears, the one below:

Conditional Formatting E
ondition 1
mﬂ Ibetween j I j‘_] and I :k_]
Preview of Farmat ko use Mo Farmat Set a— |
when condition is true: =

Add == | Delete. .. | (0] 4 I Cancel |

At the top, it says Condition 1, and there are 4 text boxes to fill in. The first two "Cell Value Is" and
"Between" will suit our purposes, so:

. Click inside the third text box and enter 80
. Click inside the fourth text box and enter 100
. You should have "Cell Value Is between 80 and 100"

You can now set the colour to use for this condition. So click the Format button. Another dialogue box appears.
From the Patterns Tab Strip, select a colour or pattern to use. Then click the OK button at the bottom. Your
dialogue box will look something like the one below:

Conditional Formatting
ondition 1
ICEII Yalue Is j Il:uetween j ISIII j‘_] and IlDEI jl_]
Preview of Format to use AaBhCoY Iz
when condition is true: ¥

add == | Delete. .. | o4 | Cancel |

You can now add a second condition. To do that, click the Add button at the bottom of the dialogue box.
Condition 2 will appear. Repeat the above process: enter some numbers for the middle set of grade (65 to 79,
perhaps), and select a different colour by clicking the Format button. Add a third condition for the lowest
grades. When you're done, click the OK button. Your Overall Averages should change colour depending on what
grade the student got. (Unfortunately, Excel only allows you a maximum of 3 conditions.)

Your spreadsheet might look something like the one in the next image:

Steven Mary Ann  Raymond Mark Paul Eliza Kelly
Maths 76 a9 43 48 a1 76 ar ]
English 55 a5 78 61 47 a7 91 73
Science B5 g2 39 58 52 B5 57 45
History 45 a1 56 72 49 56 7g 56
Geography 51 g4 54 B4 47 B4 67 67
Art 43 B3 49 B2 39 g4 64 B3
Computer Studies 63 95 45 59 41 a2 g3 52
French 35 2 B5 26 20 51 a2 56
Overall Average 541 B850 836  5B3 443 725 78.1 585

The conditional formatting allows you to see at a glance which students are doing well, and which are doing
badly. Poor Mark!

Exercise
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Format the Student Grades so that your spreadsheet looks like the one below (you can use different colours, if
you like).

In the spreadsheet above, you can now see more easily who's doing well and who isn't. In the next section, we'll
take a look at CountlF. Again, we'll use the student spreadsheet.

Move on to CountlF -->

<--Back he Excel Contents P
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Using the CountlF Function in Microsoft Excel

The next Conditional function we're going to use is CountlF. This one is fairly straightforward. It looks at a range of cells and
tells you how many of them meet the criteria that you set. Once again, we'll use the student exam marks spreadsheet.

Copying and Pasting Data to a new Sheet

Open up the Spreadsheet you used for the |ast section. (If you haven't yet downloaded the spreadsheet, click here: Download
the spreadsheet.)

Because the exam spreadsheet might be a little full, we'll start on a new sheet. We'll copy and paste the student data onto
sheet 2. To do that, follow these steps:

e Highlight the data you want to copy
* Forus, that's the student data, as in the image below:

+ With the data highlighted, click on Edit from the menu bar
« From the drop down list, click on Copy. The marching ants surround your highlighted data
* Look at the bottom of the spreadsheet and locate Sheet2, as in the next image:

21 |Computer Studies B A C
22 |French D A B
23
M [« ¥ [ sheetl  sheetz £ sheets /

Click on Sheet2 with your left mouse button

The blank Sheet2 spreadsheet should appear

Click inside cell A1

Press the Return key on your keyboard to paste the data (Or click Edit > Paste from the Excel menu bar)

Add the following labels to Sheet2 of your spreadsheet:

|11 [Overall Average | 541 850

Ph:meuderﬂ:#ﬁM 5;2-§Epre__.-df 70

| 21 |Computer Studies
22 |French

We'll now use the CountlF function to see how many of the students were above a score of 70 in each subject.

CountlF
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The Countlf function only calculates things when a certain condition is met. For example, only count the students whose
grades are above B.

The CountlF function uses this syntax:
COUNTIF(range, criteria)

In other words, it takes two arguments. The first argument is range, and this means the range of cells you want to count. The
criteria is what you want excel to look for when it is counting. Let's see it in action.

o Click inside cell B15
o Click inside the formula bar
e Enter the following function:

=Countlf(B2:12, ">= 70")

e Press the return key on your keyboard
¢ The answer you should have got was 4

The formula says, look in cells B2 to 12. Then check for a score of greater than or equal to 70. If you find this score, keep a
Count.

So 4 students achieved a mark of 70 or above for Maths. To do the rest of the scores, you can use AutoFill. When you have
finished, it should look like this one below:

[}

Num Students Above a Score of 70

)
|

] [ (o e
l:l'i_ClD:l"*-Jm|U‘lJ=-

Maths

English

Science

History
Geography

Art

Computer Studies
French

|
22
B Q)| — | — ()| — O =

)
[}

CountlF is a very useful function for simple data analysis.

In the next part, we'll take a look at two more useful functions: AND and SUMIF.

Move on to AND an MIFE -->

<--Back to the Excel Contents Page
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How to use the AND and SUMIF Functions
INn Excel

Two more useful Conditional Functions are AND( ) and SUMIF( ). We'll stay with the students exam results
to examine these two functions. If you haven't yet downloaded the spreadsheet we're using for these
lessons, click below. (If you've been following along, you can use this new spreadsheet: it has the CountIF
already done!)

Download the spreadsheet for this section

The AND Function

Here's the scenario. The government have decided to take a closer look at school averages. If 4 or more
students in a subject get a score of 70 or above, then the school gets a cash bonus for that subject. There
are 8 subjects, so 8 cash bonuses are up for grabs.

First, we'll use the AND function to work out if 4 or more students have scores of 70 or above.

The AND( ) function checks a list of arguments and determines whether they are true or false. If all the
arguments are true then the function gives you an answer of TRUE. If one or more of the arguments are
false, then the function gives you an answer of FALSE.

To give you an easy example. You can check whether two plus two does indeed equal 4. Click inside an
empty cell of your spreadsheet, then click inside the formula bar. Enter this:

=AND(2 + 2 = 4)

When you press the Return key, Excel gives you the answer TRUE. Now change itto 2 + 3 = 4 and see
what happens.

So Excel checked the argument to see whether it was true or false. That's all it will check for, an either or
answer. You can have up to 30 arguments between the AND brackets. You could have this, for example:

= AND(2+2=4, 1+2=4)

There's two arguments to check there. Excel will check the first one and return an answer of TRUE. When it
checks the second one it will return an answer of False. The answer to the whole function will then be
FALSE. (It's false because all conditions have to be true before the overall answer is TRUE.)

Our AND function is going to be quite simple. We're going to check the B column, the Number of students
who have Below Average scores.

. So click inside C15
D Click inside the formula bar
e  Enter the following formula :

= AND(B15 >= 4)

Press the return key on your keyboard

Excel will enter True in this cell (B15 is the cell where we had a score of 4)
Use Auto Fill to calculate the rest of the AND functions

Your spreadsheet should look something like the one below:
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13 |Num Students Above 70
14
15 |Maths 4 TRUE
16  English 5 TRUE
17 |Science 1. FALSE
13 | History d  FALSE
15 |Geography 1 FALSE
20 Art 1 FALSE
21 |Computer Studies 3 FALZE
22 |[French 2 FALSE

All we're saying in our function is "IF the cell B15 is greater than or equal to 4 THEN put True in cell C15,
else put False". Remember: the government pays out if 4 or more students get above a score of 70 for a
lesson

Now that we have some True/False values for our C column, we can check all these True/False values.
We want to add up all the cash values associated with our TRUE cells. However, we haven't got any cash
values yet, so let's do that now. Enter the same cash values as in the image below:

13 |Num Students Above 70

14

15 |Maths 4 TRUE £10,000
16 |[English 5 TRUE £ 5000
17 |Science 1/ FALSE £ 8000
15 |History 3 FALSE £ 4000
19 |Geography 1 FALSE £ 4000
20 |Art 1 FALSE £ 2000
21 |Computer Studies 3| FALSE £ 8000
22 |French 2 FALSE £ 1,000

The values are just potential values. A school only gets them if 4 or more students gain a score of 70 or
above in that subject. So there's a potential ten thousand for Maths, five thousand for English, 8 thousand
for Science, etc.

OK, we have 2 cells with TRUE in them. There is a different cash value associated with each subject. We
have a TRUE for English, so the school will receive 5 thousand pounds for this. The school can expect 10,
000 for Maths. But we need a way to add all the cash values associated with the TRUE values. We can
use SUMIF for this.

SumlF

SUMIF is a little bit more complicated than AND, but not much more. This function adds up things
depending on the criteria you give it. (Add up the cost of all apples, for example.) The function expects
certain arguments. These are:

SUMIF(range, criteria, sum_range)

The first argument, range, is the cell or cells you want to check. For us, this would be the TRUE and
FALSE values in the D column. The second argument, criteria, is what you want to check for. In our case
this is the value TRUE. The third argument, sum_range, are the cells to add up. The figures we want to
add up are all in the E column.

e Soclick in an empty cell (E24 is ideal for us)
e Click inside the formula bar
e  Enter the following SUMIF function:

=SUMIF(C15:C22, TRUE, E15:E22)
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e Press the return key on your keyboard
e  Excel adds up only the value associated with TRUE

If everything went well, then you should have a figure of 11 thousand for your SUMIF function. Your
spreadsheet might look like the one below:

13 [Num Students Above 70

14
15 |Maths 4 TRUE £ 10,000
16 |English 5 TRUE £ 5000
17 |Science 1 FALSE £ 8000
18 |History 3 FALSE £ 4000
19 |Geography 1 FALSE £ 4000
20 |Art 1. FALSE £ 2000
21 [Computer Studies 3 FALSE £ 5,000
22 |French 2 FALSE £ 1,000
e
24 |Money Earned £ 15,000

25

So our SUMIF function said "Check the cells C15 to C22. If a cell has TRUE in it, make a note of the
ammount in the E cell next to it. When you've finished, add them all up.”

The SUMIF might be a bit tricky to master, but it can come in quite handy, and it's worth making the effort
to understand exactly how it works.

In any case, that concludes are little journey into conditional logic. Hope you're not too disappointed to be
leaving the subject behind!

In the next section of the Excel course, we'll take a look at Tables, Scenarios and Goal Seek.
Move on to the next section of the Excel course -->

<--Back to the Excel Contents Page
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How to Use Microsoft Excel Tables

In Excel, a data Table is a way to see how altering the values in a formula effects the result. Excel will work
out the new results for you, based on the new values you give it. Take the following as an example:

You decided to take out a loan of ten thousand pounds. You want to pay back the loan over 5 years. The
first bank you try sets a interest rate of 9 percent per year. You use the PMT formula to work out how much
you have to pay back every month:

=PMT((9% / 12, 12 * 5, -10000)
The formula gives you a figure of £207.58 per month.

However, another three banks are after your business. They are offering interest rates of 8 percent, 7
percent, and 6 percent. You can use the PMT function again to work out the monthly payments for these
interest rates, or you could just use a cell reference for that 9% figure in the formula.

Another way to work out the monthly payments for the new interest rates is to use a Table. Excel will then
use the PMT function, and the new interest rates, and work out the answers for you. We'll see how to do
that now.

Excel Tables
e Start a new spreadsheet

e Enter the same labels as in the image below
. Enter the same values for the Rate, Months, and Loan

A | B | ¢ | D
_1 |Payment Terms
2
3 Rate 9.00%
_4 |Months B0
5 |Loan £10,000
B
7

So the Rate (interest rate) is 9 percent, the Months value is 60, and the Loan is 10, 000 pounds.

o Click inside cell D2
D Click inside the formula bar
Enter the following formula:

=PMT(B3/ 12, B4, -B5)

Press the return key on your keyboard
Excel should give you the answer £207.58

Just in case you're unsure about that PMT Function, here's what it's doing. The first argument for PMT is
the rate, meaning the interest rate. The cell B3 is where we had our interest rate of 9 percent. We need to
divide that by 12 (the number of months in a year), otherwise the bank will be charging us 9 percent a
month! The second argument, where we have B4, is nper. This is just the total number of months in our
loan. The third argument is how much we want to borrow. We have this amount in cell B5. It is a minus
figure because it's a debt.

Now that we have a function in place, we can construct our Excel Table. First, we need to tell Excel about
those other interest rates. It will use these to work out the new monthly payments. Remember, Excel is
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recalculating the PMT function. So it needs some new values to calculate with.

e Soincells C3, C4, and C5 enter 8%, 7%, 6%
e Your spreadsheet should look like the one below

A | B | ¢ | D |
_1 |Payment Terms
2] £207.58
~ 3 |Rate 9.00%  5.00%
_4 Months B0 7.00%
5 |Loan £10,000 B.00%
B |
7

We have deliberately put the PMT function in cell D2. This is one Row up, and one Column to the right of
our first new interest rate of 8%. The new monthly payments are going to go in cells D3 to D5. Excel needs
you to set the table out this way.

So that Excel can work out the new totals, you have to highlight both the new values and the Function.

e Soclick inside cell C2
e Highlight the cells down to D5
e Your spreadsheet should look like this one:

A | B | Cc | D |
_1 |Payment Terms
2 £207.58
_3 |Rate 9.00%) 5.00%
_4 |Months B0y 7.00%
_9 |Loan £10,0000 B.O0%: 1
B

As you can see, the cells C2 to D5 are highlighted. This includes our new interest rate values, and our
function in cell D2. We can now create a Table. So do this:

e  From the Excel menu bar, click on Data
¢  From the drop down menu, click on Table
A small dialogue box appears like the one below:

Table EHE

Row input cell: || =k:]
Column input cell; I =k:]

(0] 4 I Cancel |

There's not much to fill in on that dialogue box. But the term "Input Cell" does need explaining.

The Input Cell is the cell that you want Excel to substitute. The thing we want Excel to substitute is the
interest rate. We had our interest rate in cell B3. So we use this as the Input Cell.

We wanted Excel to fill downwards, down a column. So we need the second text box on the dialogue box
"Column input cell". If we were filling across in rows, we would use the "Row input cell" text box.

e Soclick in side the "Column input cell” text box

e Enter B3 as the Input Cell

e Click the OK button

o  Excel will work out the new monthly totals for you

¢ You should have the same values as in the image below:
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A | B | ¢ | D |

_1 |Payment Terms
2] £207.58
~ 3 |Rate 9.00%  5.00% 0278
_4 Months B0 7.00% £198.01
5 |Loan £10,000 R.00% £193.33
B |

7

So at an interest rate of 9 percent, we would be paying back just over two hundred and seven pounds.
Excel has worked out that an interest rate of 8 percent will lower the monthly payments to just over two
hundred and two pounds. At a 6 percent interest rate, the payments will be just over one hundred and
ninety three pounds.

If you click inside cells D3, D4 and D5, then look at the formula bar, you will see this:
{=TABLE(,B3)}

That's Excel's way of telling you that a Table has been created.

We'll do one more Table. This time we'll use a more simple formula than PMT, and we'll use Rows instead
of Columns. We'll do that in the next part.

Move on to another Excel Table example -->
<--Back to the Excel Contents Page
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If you missed the first part of this tutorial, it can be found here: Excel Tables, Part One.

Part Two of Excel and Tables

In the previous part, we saw how to use an Excel Table to work out interest rates. The Table was used to
fill out several values at once. We'll now see how to use a Table to examine profir margins. Here's the
scenario:

You take 250 items to a Car Boot sale. Your Unique Selling point is this: All items only a pound each!
Except you feel that one pound might be a bit expensive, especially for the goods you're selling! What you
want to know is how much profit will you make if you reduce your prices to ninety pence each, how much if
you reduce to 80 pence each, and how much if you reduce to 70 pence each. Assume that everything gets
sold.

To start creating your Table, construct a spreadsheet like the one below. Make sure that you start on a new
sheet.

A | B | ¢ | b | E |
NHumher 260
Price £1.00
Reductions 1] £0.90 £0.80 £0.70

Sales

L7 | e | 0| D | —

Number is the number of items we're taking to the Car Boot sale. Price will be used in our formula.
Reductions is the amount we want to reduce by. Sales is the amount of profit we expect to make. Our
formula will go in cell B4. So click inside cell B4 and enter the formula:

=Bl *B2

The answer is, of course, 250. But the answer is in cell B4 for a reason. This is because when you want
Excel to recalculate a Table in Rows, the formula must be inserted one Column to the Left of your first new
value, and then one Row down. Our first new value is going in cell C3. So one column to the left takes us
to the B column. One row down is Row 4. So the formula goes in cell B4.

Next, click inside cell B3 and highlight to cell E4. Your spreadsheet should now look like the one below:

A B | ¢ | b | E |
1 |Humher 260
2 |Price £1.00
3 |Reductions 1] £0.90 £0.80 £0.70
4 |Sales £250.00 1
g

Excel is going to use your formula in cell B4. It will then look at the new values on Row 3 (not counting the
zero), and then insert the new totals starting in cell C4.

So with the data highlighted, click on Data from the menu bar
From the drop down list, click on Tables
The Table dialogue box appears
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Table 7] ]

Fow input: cell: || =k:]
Column input cell; I =k:]

(] 4 I Cancel |

We want Excel to fill our new values in Row 4, so we need the Row input cell. But what is the Input Cell
this time?

Ask yourself what you are trying to work out, and what you want Excel to recalculate. You want to work out
the new prices. So you need the old price. The old price of each item was one pound, and you used this in
the formula.

e So onthe Table dialogue box, click inside the "Row input cell" text box
e Enter your cell reference

¢ Click OK when you are done

e Ifyou got it right, your spreadsheet will look like the one below:

A | B | ¢ | D | E |
1 |Humher 260
2 |Price £1.00
3 |Reductions 1] £0.90 £0.80 £0.70
4 |Sales £250.00 02275 £200 £175
5

So, if you don't reduce your prices, you will make two hundred and fifty pounds. If you reduce the price of
each item to seventy pence, you will make one hundred and seventy five pounds.

Tables are a useful tool when you want to analyze values that can change. Before moving on, try this
exercise.

Exercise
Amend the table above. This time, instead of reducing your prices, you are going to increase the price to

£1.25 per item, and increase the number of items you sell. You currently sell 250 items. Work out the new
profits if you sell 300 items, 350 items, and 400 items.

In the next part, we'll move on to Scenarios.

Move on to Excel Scenarios -->

<-- Back to the Excel Contents Page
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How to use Scenarios in eExcel

Scenarios are similar to Tables, in that you are asking "What if*? "What if | change this value, or that
amount? What will the spreadsheet look like then?" The difference is that you can create a number of
different scenarios and save them.

An example of a scenario you might want to create is this:

You've worked out the family budget, and find you have barely enough left for a night out. The question is,
what can you cut back on to give yourself more spending money?

We'll create a spreadsheet to tackle that problem, and you'll see how scenarios work. To get started,
there's a new spreadsheet for you to download:

Download the Spreadsheet for this section

When you open up the spreadsheet, you'll see there is only 46 pounds left at the end of every month. And
the cost of the car hasn't even been included yet! Clearly, some cutbacks have to be made.

With a scenario, we can switch between our different budgets and see which one we like best. The best
way to see how a scenario works is to construct one yourself.

Scenarios

To create your scenario, do the following:

e  From the Excel menu bar, click on Tools
e  From the drop down menu, click on Scenarios
e The Scenario Manager dialogue box pops up

Scenarnio Manager EE

Mo Scenarios defined, Choose Add to e |
add scenarios.
Close |

I
dd, ..

Delete |
Edit... |

Zhanging cells: Merge. ..

| SUMMAarsy. .. |

Comment:

¢ We want to create a new Scenario, so click the Add button
¢ The Add Scenario dialogue box pops up
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Add Scenario EiE3

SCenario name:
Zhanging cells:
J116 Y

Ckel+click cells to select non-adjacent
changing cells.

Comrment:
Created by ;I
-
Protection
¥ Prevent changes ™ Hide

(a4 | Cancel |

¢ Click inside the Scenario Name text box and type Original Budget

You now need to tell Excel which cells will be changing. Although nothing will be changing in this scenario
(because it's our original), we still need to specify which cells will be changing. We want to reduce the Food
bill, the Clothes Bill, and the Phone bill.

¢ Soclick inside the Changing Cells text box

¢ Click back on your spreadsheet and highlight cells B7 to B9

e The "marching ants" will appear around your selected area, and your dialogue box will look like this
one:

Edit Scenario 7| =]

SCenario name:

|Original Budget

Zhanging cells:
[s847:5844] =i

Ckel+click cells to select non-adjacent
changing cells.

Comrment:
Created by ;I
=
Protection
¥ Prevent changes [~ |Hide

O I Zancel

¢ Click the OK button at the bottom

e  Excel will prompt you for the Scenario Values

¢ We don't want the values on the original to change, so just click OK

e You are taken back to the Scenario Manager dialogue box, and you'll see the scenario you have just
created displayed.

We now need to create another Scenario, so that we can switch between the original budget and the new
one. So click the Add button to add a new scenatrio.

e When you get the Add Scenario dialogue box back up again, click inside the Scenario Name text
box and type Budget Two.

Content downloaded from www.homeandlearn.co.uk



Created By www.ebooktutorials.blogspot.in

e The Changing cells text box should read B7:B9. These are the cells we want to change, so leave
them alone

¢  Click the OK button at the bottom of the Add Scenario dialogue box

e You will be taken to the Scenario Values dialogue box. It looks like the one below:

Scenario Yalues EE3

Enter values For each of the changing cells,
547 |
B3 Cancel |

4848 [150

|l—l-

I

Add
449 |45

1=

The values in the Text Boxes are the ones from cells B7, B8, and B9. Click inside each text box and type in
a different value. The 280 spent on food can be changed to something like 180. Take 50 off the clothes bill.
And take 20 off the phone bill. Your dialogue box will then look like this one:

Scenario Yalues EE3
Enter values For each of the changing cells,
4647 {180

4848 [100

464 |25

|l—l-

il

Zancel

I

o2
=
CL
[w

Click the OK button when you're done. You'll be taken back to the Scenario Manager. And this is where the
fun starts.

To view a scenario, click on one from the list. Then click the Show button. In the image below, Budget
Two has been selected:

Scenarnio Manager

SCenarios:

|Ori§inal Budiet - | Show

Close

ail.

add. .

Delete
ﬂ Edit...
Changing cells: Merge. ..
$E§7:4E40

Comment:

l(reated by

After you click the Show button, have a look at your spreadsheet. The figures should have changed. Select
Original Budget from the list, then click the Show button. Your spreadsheet should show the original
figures.

il

L

SUMMary. ..
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Click the Close button on the dialogue box when you're done. To view your two scenarios again, just click
on Tools > Scenarios. This will bring up the Scenario Manager again.

So a Scenario offers you different ways to view a set of figures, and allows you to switch between them
quite easily.

Scenario Reports

Another thing you can do with a scenario is produce a report. This is quite easy. To produce a report of
your scenarios, do the following:

e Click on Tools from the menu bar

e  From the drop-down menu, click on Scenarios
e The Scenario Manager dialogue box appears

e Click on the Summary button

e The following dialogue box appears

Scenario Summary EEd

Report bype
¥ Scenario SUMMary
"~ Scenario RivotTable

Result cells:
1z

e To change the result cells, click on your spreadsheet

e Click individual cells by holding down the Ctrl key on your keyboard, and then clicking inside a cell
with your left mouse button

e So hold down the Ctrl key and click on cell D3 (income)

e Hold down the Ctrl key and click on cell B12

e Hold down the Ctrl key and click on cell D13

+ If you make a mistake and want to get rid of a highlighted cell, just click inside it again with the Ctrl
key held down

e Click OK when you're done

o  Excel will produce the Summary for you. It will look something like the one below:

Scenario Summary

Current Walues: Original Budget Budget Two
Changing Cells:

$B%7 280 280 180

$B%8 160 1480 100

$B%9 45 45 25
Result Cells:

$D%3 1200 1200 1200

$B$12 1154 1154 o054

$D$13 46 4k 216

All right, it's not terribly easy to read, but it looks pretty! Perhaps it will be enough to convince our family to
change their ways. Unlikely, but a nice diagram never hurts!

In the next part, we'll take a look at Goal Seek, what it is and how to use it.
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Move on to Goal Seek in Excel -->

<-- Back to the Excel Contents Page
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How to use Goal Seek In Excel

We're not going go too deeply into Goal Seek, because it can get quite complicated. We'll stick with a basic
outline, and an example, of just what it is.

Goal Seek

Goal Seek is used when you know what answer you want, but don't know the exact figure to input for that
answer. For example, you're quite certain that 8 multiplied by something equals 56. You just not sure what
that missing number is. Is it 8 multiplied by 67 Or Is it 8 multiplied by 7? Goal Seek will tell you the answer.

We'll test that example out right now. So start a new spreadsheet, and create one the same as in the
image below:

B3 ~| =| =B1 * B2

A B | ©
Input 1 o
Input 2 B

Answer I 48!

M| bl | B0 | —

Before you can use Goal Seek, Excel needs certain things from you. First it needs some sort of formula to
work with. In the image above we have the simple formula =B1 * B2. We've put this in cell B3. But the
answer is wrong for us. We had a Goal of 56 (8 times something). We want to know which number you
have to multiply 8 by in order to get the answer 56. We tried 8 times 6, and that gave the answer of 48. So
we have to try again.

Instead of us puzzling the answer out, we can let Goal Seek handle it. So do the following:

e  From the Excel menu bar, click on Tools
e  From the drop down menu, click on Goal Seek
e Adialogue box pops up like the one below:

Goal 5eek 7]
Set cell: I_ :“J
Ta value: I

By changing cell: | :".]

(] 4 I Cancel |

The dialogue box needs a little explaining. "Set cell" is the answer you're looking for, this is the Goal. Set
cell needs a formula or function to work with. Our formula is in cell B3, so if your "Set cell" text box does not
say B3, click inside it and type B3.

"To Value" is the actual answer you're looking for. With "Set cell", you're just telling Excel where the
formula is. With "To Value" you have to tell Excel what answer you're looking for. We wanted an answer of
56 for our formula. So click inside the "To Value" text box and type 56.

"By Changing Cell" is the missing bit. This is the part of the formula that needs to change in order to get
the answer you want. In our formula we have an 8 and a 6. Clearly, the 6 is the number that has to go. So
the cell that needs to change is B2. So go ahead and enter B2 in the "By Changing Cell" text box. Your
dialogue box should now look like this:
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Goal S5eek 7] %

Set cell: IBS :"J

To walue: ISE'

Ey chanaging cell: |82| :"J
fa's I Zancel |

Click OK when your dialogue box looks like the one above. Excel will then Set the cell B3 to the Value of
56, and change the figure in cell B2. You'll also get a dialogue box like the one below:

Goal 5eek Status K |

Goal Seeking with Cell B3
found a solukion,

Cancel
Targek value: 56

Current value: 56 Skep

N
[ pase |

Pause

Click OK on the dialogue box. Your new spreadsheet will look like this one:

B3 | =| =(B1 * B2
A B | c
Input 1 o
Input 2 7

Answer I EE!

M| bl | B0 | —

So Goal Seek has given us the answer we wanted: it is 7 that when times by 8 equals 56.

Increase your profits with Goal Seek

To give you a more practical example of what Goal Seek does, consider this problem. You have a business
that generates 25 thousand pounds worth of profit. You currently sell 1000 items at 25 pounds each. You
want to increase your profit to 35 thousand pounds. Assume that you're still going to sell 1000 items. By
how much does the price of each item have to increase by in order to generate the new profit total?

We'll work it out together using Goal Seek. And then you can have a try yourself with an exercise. First,
here's a new spreadsheet for you to download:

Download the Goal Seek Spreadsheet

When you open the spreadsheet, you'll notice that the Current Sales Figures and the Future Sales Figures
are exactly the same. The formula in Cells B4 and E4 are = B2 * B3 and = E2 * E3

We can use Goal Seek to solve our problem. What we want to know is, What should be the new Price Per
Item in order to generate Profits of 35 thousand?

o So, from the Excel menu bar, click on Tools

e  From the drop-down menu, click Goal Seek
e The Goal Seek dialogue box appears
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Goal Seek EHE
Set cell: I :“J
To salue: I

By changing cell: | :".]

o ]

Zancel |

This time, our formula is in cell E4. So we want to Set the cell to the cell that has our formula. So type E4

into the "Set cell" text box.

The "To Value" text box will hold our new Profits. The Goal we are aiming for is 35 thousand. So type in

35000 in the "To value" text box.

The cell we want to change is the Price Per item figure. So in the "By changing cell" text box, type in E3.

Click OK when you're done. Excel will give you this dialogue box:

Goal 5eek Status

Goal Seeking with Cell E4

found a solukion,

Zancel
35000

£35, 000,00

Target value:

Current value: Skep

Pause

5= |
e |

The dialogue box is telling you that Goal Seek has found a solution. Click OK. Your spreadsheet will
already have changed. The new Future Sales Figures will be displayed. Your spreadsheet should look

something like the one below:

A, | B | C | D | E
. Current Sales Figures Future Sales Figures
|2 |Items Sold 1000 Items Sold 1000
.3 |Price Per ltem | £ 25.00 Price Per ltem 35.00
|4 |Profits £ 2500000 Profits 35,000.00
5
6|

Goal Seek has given us the answer of 35 pounds. So the cost of each item has to increase by 10 pounds if

we want a profit of 35 thousand.

And now it's your turn. Try this exercise.

Exercise

You've had a board meeting. It has been decided that the Price Per Item will remain the same - 25 pounds.
But you still want to generate Profits of 35 thousand. Use Goal seek to work out how many Items will now

have to be sold in order to reach your target.

And that's it for this section. In the next section, we'll take a look at Absolutes versus Relative cell

referencing, Named Ranges and Pivot Tables. There's a lot to get through!

<--Back to the Excel Contents Page
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Absolute and Relative Cell Referencing in
Excel

There are two important spreadsheet concepts we haven't yet explored: absolute cell references, and
relative cell references. We'll explore these two ideas now. First, absolute cell references.

Relative cell references in Microsoft Excel

Take a look at the spreadsheet below (create it for yourself):

B2 | =[ =A1 + A2
I A [

20
26] 4]

o | LT [Pl | —

As you can see, it's quite simple. All we are doing is adding together the numbers in cells A1 and A2. We
then put the answer in cell B2.

But suppose we wanted to copy the formula in cell B2 to cell B3. Let's try it and see what happens.

e Click inside cell B2

¢ Then click once with your right mouse button
e A menu pops up

With your left mouse button, click Copy

Now click inside cell B3

Click once with your right mouse button
When the menu pops up, click on Paste

Your spreadsheet will look like the one below:

b |l | PO —
H
7
= ]

Excel has done something rather odd. It has given us the answer 25! The sum 20 + 25 clearly does not
equal 25, so what's going on?

Well, look inside the formula bar. The formula is now reading = A2 + A3. Yet that was not the formula we
pasted from cell B2. We copied and pasted the formula = A1 + A2. So why did Excel copy and paste the
wrong formula?

The answer is that we used a Relative cell reference for B2. We have been using Relative cell references
throughout this book. This is Excel's default, and it works like this when you copy a formula:

The formula is = A1 + A2. The answer is in cell B2. When copying the formula to cell B3 Excel will note
that the cells for the formula start UP one Row, and LEFT one column. When you paste the formula
somewhere else, Excel will not paste the formula, but paste this UP one then Left one. So starting at Cell
B3, which is where we're pasting to, go UP one Row. This takes you to row 2. Then go one column Left.
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This takes you to Column A. So the start for the new formula is cell A2. Your formula will now read = A2 +
A3. As there is nothing in cell A3, the formula is really = 25 + 0. Which gives the answer 25.

And that's Relative cell referencing.
Absolute cell references in Microsoft Excel

If you want to keep a reference to the original cells, A1 and A2, you need to use Absolute cell references.
Absolute cell referencing is done with dollar signs.

Change your formula in cell B2 to this:
= $A$1 + $AS2

Then copy and paste the new formula to cell B3. You should now get the answer you were looking for: 45.
Your spreadsheet will look like the one below:

B3 | =| =§A51 + FA%2
e e

1

2 25 45
[e1 =l

A

To recap, then:

« When you want to copy and paste formulas, use Absolute cell references
e To use Absolute referencing, place a dollar sign before the Column letter and a dollar sign before the
Row number (You can mix absolute and relative cell references, but we won't go into that.)

In the next part of this section, we'll take a look at Named Ranges.

Move on to Named Ranges -->
<--Back to the Excel Contents Page

Content downloaded from www.homeandlearn.co.uk



Created By www.ebooktutorials.blogspot.in

How to Set Up Named Ranges in Excel

Instead of using something like = SUM(A2:A5) to add up a column of numbers, you can replace the A2:A5
part of the function with a more descriptive name. This is known as a Named Range. Examine the
spreadsheet below:

A B | C
L Monthly Totals  Monthly Tax
e 124 12
3 | 234 23
4 344 34
5 Results 702 69
B

In the Results Row, cell B5 is a result of adding up cells B2 to B4. The formula used is just this:
=Sum(B2:B4)

Now examine the same spreadsheet, but with a Named Range used:

Result_Totals | =| =SUM(Monthly_Totals)
A B | C |

1 Monthly Totals  Monthly Tax

2 124 12

3 234 23

4 344 34

5 |Results | 702 1 69

B

This time, cell B5 doesn't have in it the formula = Sum(B2:B4). As you can see, it has
=SUM(Monthly_Totals). This is the label from B1. We have created a Named Range. The formula in cell
B5 is now more descriptive. We can tell at a glance what it is we're adding up. Excel has replaced the
B2:B4 part with the name we gave it. Behind the scenes, though, we're still adding up the numbers in cells
B2 to B4. Excel has just hidden the cell references behind our descriptive name.

You'll now see how to create your own Named Ranges.

Creating a Named Range

Start a new spreadsheet, and enter the same data as in the image below:

B5 =] =| =SUM(B2:B4)
A B | e | D

1 Monthly Totals Monthly Tax
2 124 12
3 234 23
4 344 34
5 |Results | 702 !
B

Make sure you have the same formula in cell B5 =Sum(B2:B4). We're going to create a Named Range,
and then pop it in cell B5. To create a Named Range then, do the following:

e Highlight the B column, from B2 to B4 (Don't include the formula when you're highlighting. Just
highlight the same cells as the ones in the function)
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e  From the menu bar, click on Insert
e  From the drop-down menu select Name
e A sub menu appears like the one below:

Insert Format Tools Data Window Help A
Zells...
Rows
Columns
W'orksheet

ﬂ Chatt. ..

Page Break,

F+ Function...
ﬁ Commenkt Easter,,
Create. ..
Al
Label, .,

Picture 3
Obiject. ..
% Hypetlink, ..  Chrl+k

There's a two-step process involved with setting up a Named Range. The fist thing to do is Define the
name. You then Apply the name to your formula.

. So select Define from the sub menu
e The Define Name dialogue box pops up. This one:

Define Hame

Marmes in workbook:

Refers bo;
I=namedranges!$B$2:$B$4

With the B column highlighted, Excel will use your label at the top as the name (Monthly_Totals for us). But
you can change it if you want. Notice the narrow text box at the bottom, "Refers to". This is showing the
highlighted cells.

Click OK on the dialogue box.

You are returned to your spreadsheet. Nothing will happen. This is because we have haven't done step
two of the two-step process - Applying the name.

To apply your new name to a formula, do this:

¢ Click inside the cell where your formula is, B5 in our case

¢ Click on Insert from the menu bar

¢  From the drop down menu, select Name

e From the sub menu that appears, click on Apply

e A dialogue box will appear showing a list of all the Names you have set up

You'll have only one Name set up , so there's not much to do except click the OK button.
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When you click OK, Excel should adapt your formula in cell B5. If you've done it right, your spreadsheet
should look like the one below:

BS | =| =SUM(Monthly_Tatals)
A B | C |
1 Monthly Totals  Monthly Tax
2 124 12
3 234 23
4 344 34
5 |Results | 702 !
B

As you can see, the cell B5 now reads =SUM(Monthly_Totals). Excel has hidden the cell references
behind the Name we defined.

If you didn't get the Name, but instead got the error message below, then there are a couple of things you
can do:

Microzoft Excel E3

& Microsaft Excel cannok find any references to replace,

Before you click Insert > Name > Define, make sure you highlight only the same cells as the ones in
your formula. Make sure that there is a formula in the cell B5, and that it says = SUM(B2:B4)

We can enter another Named Range for our Monthly Tax column, column C. Here's a break down of the
Two-Step process involved with setting up a Named Range.

Step One - Define the range of cells

e  Enter your Formula (In cell C5, enter = SUM(C2:C4))

e Highlight the same cells that are going in your formula

e  From the menu bar, click Insert > Name > Define

« From the Define Name dialogue box, either accept the name Excel gives you, or type your own
name for the range of cells you're going to define

e Click OK

Step Two - Apply the Name

e Click inside the cell where the formula is (cell C5 for us)

e« From the menu bar, click Insert > Name > Apply

e« From the Apply Name dialogue box, click on the Name you want to use

e Click OK

o Excel will insert the name, if it can, and hide your cell references behind the name

So go ahead and insert a Named Range for cell C5. When you're finished, the spreadsheet should look
like the one below:

C5 =] =| =SUMMonthly_Tax)
A B | C |

1 Monthly Totals Monthly Tax
2 124 12
3 234 23
4 344 34
5 |Results 02 | 69 !
B
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As you can see, cell C5 no longer reads = Sum(C2:C4). Instead, we have a Named Range in cell C5.

In the next part, we'll see how to use the Named Ranges you have just set up.

Move on to Using Named Ranges -->
<--Back to the Excel Contents Page
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How to Use a Named Range in Excel

In the previous part, you saw how to define and apply Named Ranges. In this part, you'll learn how to use
the Named Ranges you have just set up.

Using Named Ranges

The spreadsheet you have created so far looks like this:

C5 | =| =SUM(Monthly_Tax)

A B | C |
1 Monthly Totals Monthly Tax
2 124 12
3 234 23
4 344 34
5 |Results 702 | 69 |
B

We have a Named Range in Cell B5 Called Monthly_Totals, and a Named Range in Cell C5 Called
Monthly_Tax. We can use the Named Ranges to deduct the Tax from the Monthly Totals. But we need to
set up two new Named Ranges. One for cell B5 and one for cell C5.

You might question the need to set up two more Ranges, on the grounds that we have just set up two
Named Ranges in cell B5 and C5.

Strictly speaking, we don't need the new names. To deduct the Tax from the Monthly Total using Named
Ranges we could just do this:

=Sum(Monthly_Totals) - SUM(Monthly_Tax)

And it would work. Excel would take one from the other. (The following, however, would not: =
Monthly_Totals - Monthly_Tax.)

But if we set up two more Named Ranges, we can just use the single totals, instead of telling Excel to use a
Function to add them up first.

So, to define two new Names, do the following:

e Click inside cell B5

e  From the menu bar, click on Insert > Name > Define

 When the dialogue box appears, click inside the top text box and type in Monthly_Result. (Don't
forget the Underscore!)

e Click OK

¢ Click inside cell C5 and do the same. This time, though, type in Tax_Result as the Name.

* Your Define Name dialogue box will then look like this one:
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Define Name K

Mames in workbook:
Tax_Result | ok

Monkthly_Result ;I
Monthly_Tax Close

Manthly Tokals
M d

Deleke

[~

Refers to;

J ikl

|=namedranges!$C$5

Click the OK button when you're done.

Now that we have the Names defined, we can enter a formula and Apply the names into the formula. First,
amend your spreadsheet so that it looks like this one:

E7 - =|=B5-C5
A B | C |

1 Monthly Totals Monthly Tax
2 124 12
3 234 23
4 344 34
5 Results 702 69
B
7 |Final Total | 533!
g

As you can see, a new label has been added, along with the formula in cell B7: = B5 - C5.

Now that we have a formula we can replace the cell references B5 and C5 with the names we set up. So
click on B7 and do this:

e Clickon Insert > Name > Apply

e The Apply Names dialogue box appears

¢ Click Monthly_Result select it

e Click on Tax_Resultto select it

¢  Click the OK button

o Excel replaces your cell references with the Names
e Your spreadsheet will then look like this one:

B? - =| = Maonthly _Result - Tax_FResult
A B | C |
1 Monthly Totals Monthly Tax
2 124 12
3 234 23
4 344 34
5 |Results 702 69
B
7 |Final Total | 533!
g

The cell references in cell B7 have been replaced with our Named Ranges, making the information easier
to read.
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And that's enough of Named Ranges. We'll move on to Pivot Tables.

Learn how to create a Pivot Table in Excel -->

<--Back to the Excel Contents Page
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Microsoft Excel and Pivot tables

As you'll shortly see, Pivot Tables can become quite complex. So we'll take it easy and just design a simple
one. But first, what is a Pivot table?

What is a Pivot table?

A Pivot table is to a way to extract data from a long list of information, and present it in a readable form.
Remember the data we had from the student scores spreadsheet? You could turn that into a pivot table,
and then view only the Maths scores for each pupil. Or view just Paul's scores, and nobody else's.

To get a clearer idea of just what a Pivot Table is, examine the one below. You'll be designing this very
Pivot Table yourself shortly.

A B C | D | E F €} H

1 |Student Eliza |=

2

3 Average of Score [Subject - |

4 |Month - |An English French History haths science  |Grand Total
|5 |January 89 a7 B2 a1 B5 53 7367
| B |February 83 51 57 84 72 89 7267
7 |March 92 41 55 a1 71 41 B5.33
8 |Grand Total 83.0 9.7 53.3 8§5.3 B3.3 B2V /0.6
9

In this school, there is a test every month (it's a tough school!). The Pivot Table above shows the marks
that Elisa got in January, February, and March. There were tests for only 6 subjects. Notice the black
down-pointing arrows in the Pivot Table. On Row 1 we have Student Elisa. If the black arrow were clicked,
a drop-down box would appear showing a list of the other students. We could click on a student and view
the marks he or she achieved. Or we could select which subjects to view, or choose only one month.

But Excel does most of the work for you, and puts in those drop-down boxes as part of the wizard. But
you'll see how it works.

Before you can construct a Pivot Table, you need some data in list form. We're going to construct our Pivot
Table using only two students, Elisa and Mary. We'll use just three months worth of data, and six subjects.
You'll be glad to know that this has already been done for you. So download the spreadsheet below:

Download the Pivot Table data
In the next part, you'll start work on constructing the Pivot Table itself.

Move on to the next part -->

<-- Back to the Excel Contents Page
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How to Create a Pivot Table in Microsoft
Excel

In the previous part, you learned what a Pivot Table is. In this part, you create a Pivot Table for yourself,

using the data you downloaded. (If you haven't yet downloaded the spreadsheet, click here: Download the
Pivot Table data )

Creating a Pivot Table in Excel

The Pivot Table is constructed using a Wizard. To create yours, do the following:

e Click inside cell A2 on the spreadsheet you downloaded above
e  From Excel's menu bar, click on Data

e« From the menu that drops down, click on PivotTable and PivotChart Report
e The Pivot Table wizard starts up

PivoltT able and PivotChart Wizard - Step 1 of 3

Where is the data that vou want to analyzer?

% iicrosoft Excel fist of database!

™ External data source
™ multiple consolidation ranges
™ another PivokTable or PivokChart

Wehat kind of report do wou want to create?
* PivotTable
™ PivotChark {with PivakTable)

Cancel | < Back | Mext = I Einish |

As the Wizard says, this is step one of three. There's nothing much for us to do in step one because the
options we want are selected: "Microsoft Excel list or database" and "Pivot Table". With these options
chosen, click the Next button at the bottom.

The Wizard moves on to Step Two. It looks like this:

PivotT able and PivotCharnt Wizard - Step 2 of 3

Where is the data that wau wank ko use?

Range: -F'.' 130457

:".J Browse, ., |
Cancel | < Back | Mext = I Eimish |

The Range of cells that Excel will include in our Pivot Table is Al to D37. (You can change this if you

wanted.) Because we clicked in cell A2 to begin with, Excel has taken that as the first Row of Data. Excel

uses the labels from Row 1 as Headings. Excel will use these for our drop down boxes and data.
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Click the Next button on Step Two. Step Three of the Wizard appears. It's a little more complicated, this
time.

PivoltT able and PivotChart Wizard - Step 3 of 3

Where do you want ko put the PivokTable?

% Mew worksheet
™ Existing waorksheet

| Y

Click. Finish ko create your PivotTable,

Lavout, .. | Dptions. .. | Cancel | < Back, | Mexk = |

We'll accept the default position for the location of the Pivot Table - New worksheet. The button we're after
is Layout. So click the Layout button to see a quite complicated dialogue box. This one:
PivoltT able and PivotChart Wizard - Layout

=R [ =

Fad

Construct your PiviokTable by dragging
the field buttons on the right o the
diagram on the left,

PAGE COLUMM
Student
R DATA,

Help |

The Field Buttons the Wizard is talking about are those four on the right: Month, Subject, Student and
Score. The idea is that you click on a button. Hold down your left mouse button and drag to an area on
the left. We're going to drag one button to the Column area, one to the Row area, and one to the Data
area.

In the Row area, we'll put Month; in the Column area, we'll put Subject, and in the Data area we'll put
Score. We'll do something with the Student button after the Pivot Table has been constructed.

So do the following:

e Click on Month

e Hold down your left mouse button

e  With the mouse button held down, drag the mouse pointer over to the Row area
e Let go of the button when it's there

e A button will appear in the Row area

e The images below show the process in action

Hold Down the left Mouse button and drag
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COLUMM

Drag the mouse pointer over to the Row area

COLUMM

L

COLUMM

When you have the Month button in place, drag the Subject button to the Column area, and the
Score button to the Data area. Your dialogue box will then look like this:
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PivolT able and PivotChart Wizard - Layout
A

Frad

Construck vour PivokTable by dragaging
the Field buttons on the right o the
diagram on the left,

PAGE Subject | CcoLUmMM -
B = Subject
rlonth
Sum of Score 2 Student

Cancel

L

Help | 3

Click OK when your dialogue box looks like the one above. You will be taken back to Step Three of the
Wizard. Click the Finish button and you're done. You'll then have a spreadsheet that looks like this one:

A | &8 | ¢ | o | E | F | & | H

Sum of Score [Subject |

honth = Enalish French History Maths Soience  |[Grand Total
January 150 174 154 139 118 o3 a2a
February 142 119 150 145 126 145 827
harch 140 a2 145 158 106 a2 714
iZrand Total 432 375 450 442 350 320 2369

PivotTable
PivoktTable - @ ﬂ =15 ®§ | ! | % l%
rankh Subject Student Score N

ala|la|la|la|l s —
—lmlml e ra| = [0 OO e e T | —

If you don't see the Pivot Table toolbar, click on View > Toolbars > Pivot Table.

I'm sure you'll agree - our Pivot Table is coming along nicely. In the next part, you'll learn how to manually
add a button to a Pivot Table.

Move on to Pivot Tables Part Two -->

<--Back to the Excel Contents Page
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Extending the Pivot Table

This lesson follows on from the previous one.

We're now going to put the Students button on the Pivot Table. So do the following:

e Locate the Student button on the Pivot Table toolbar, as in the image below:

PivokTable

PivotTable - 5

T EIEENCE

Mankh Subject StI:Eent Score i

Student -- Drag button From here to the F‘ivu:utTaI:uIe|
L2

e Hold down your left mouse button on the Student button

o Keep the left mouse button held down

 Drag the Student button to the top of the Pivot table, where it says "Drag Page Fields Here."
e Let go of the left mouse button

¢ Excel adds the Student field to the pivot table

e« The two images below show the process in action

Drag the Student button to the top of the Pivot table

A .8 Jl.¢ |. b | E . F |
1 kel
2 =
3 |Sum of Scnre(lSuhieu:t ~|
4 |konth = Enaglish French History haths
|5 |January 150 174 154 139 118
B |February 142 119 160 145 126
7 |March 140 a2 14F 158 10R
B |Grand Total 432 75 450 442 350

Release the left mouse button and Excel adds the Student Field

A B C | ] |
1 | Student (AN -
2

We're almost there, now. Only a couple more things left to do. First, take a look at the scores. What the
Pivot table is doing is adding all the scores up. That's because of cell A3. Notice that it says "Sum of
Score". We don't want it to do that. An Average is much better for our purposes.

To change the Scores to Averages, do this:

. On the Pivot Table toolbar, click on the Pivot Table button
e A menu pops up like the one below:
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ﬁ Farmat Report. ..
PivotChart

Wizard. .,

! Refresh Data

ElEnt=S e e SERHTE .

Seleck »

Formulas r

O Ficld Settings...
Table Options. ..
E Show Pages. ..

e RG]

Mankh Subject Student Scare rs

| Eivu:utTaI:uIEL\‘:
o

To change the Scores to Averages, click on Field Settings
The following dialogue box appears:

PivolT able Field 7] x|
Source Field: Score
MName: | ST
Zancel |
Summatrize by
Hide |
Mumber, .. |
Options ==

on Average, and then click OK. The scores will change on the spreadsheet.

Some of the scores in the Grand Total Row and Grand Total column will be a bit long. But you can format

the numbers to in the usual way.

So highlight the Grand Total row

From the Excel Menu Bar, click on Format

From the drop down menu, click on Cells

When the dialogue box appears, select the Number tab strip
Format to 1 decimal place

Do the same for the Grand Total row

Your Pivot Table should now be looking like the one below:

We can now take a look at those drop down boxes. We'll start with the Student box.
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A B C | D | E | F | G H

1 |Student (Al -

2

3 |Awverage of Score [Subject -|

4 |Month - | Art English French History Maths SCience Grand Total
|8 |January 75 a7 77 B9.5 53 46.5 B3.0
| B |February 71 53.5 75 725 B3 725 B3.9
7 |March 70 41 73 73 53 41 53.5
8 |Grand Total /2.0 B2.5 /5.0 /3.7 53.3 533 E5.5
9
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At the moment, the Student box says All. Click the black down arrow to see the list of students.

A = | C |
1 | Student (Al -l
20 | "
3 |Average of Scaore | - Elisa
4 |Month | Mary
.5 |January
| B |February
7 |March
8 |Grand Total
19
10
11 K | cancel

Our two Students are listed there. Click on Elisa, then click the OK button. Notice how your spreadsheet
has changed. It should now only be showing you Elisa's results. Click the black down arrow in cell B1
again, and click on Mary. Then click the OK button. Your spreadsheet will change to show only Mary's
results.

Try clicking the black down arrow of Subject, in cell B3. You should see this:

1 |Student |Elisa =]

2

3 |Average of Score |Subject

4 |Manth - h

5 [January English G2
B |February French 57
7 |March Hiskary &b
8 |Grand Total Maths 58.3
g Science

10

11

12

13 I, | Zancel

All the Subjects have ticks in them. Click on a tick and it will disappear. Try un-ticking a few of the subjects.
Then click the OK button to see what happens.

The Month list in cell A4 shows a similar list with ticks in them. Un-tick a month and see the results when
you click OK.

You can add comments to pivot tables. The one below shows a Comment about Elisa's English scores:

1 [Student |Elisa =]

2

3 Average of Score [Subject |

4 |Month - | Art English French History Maths

5 |January g9 a7 b2 81 b5
b |February a3 51 Eliza's'—E_lr'linsh scores 72
7 |March g2 41 |show a rapid decline - 71
8 |Grand Total aa.0 597 [talk to student F9.3
g

10

Another thing you can do is change the type of Pivot Table Report. From the Pivot Table toolbar, click the
Pivot Table button. From the menu that pops up, select Format Report. Click on any of the formats you like
then click OK to see what happens. If you don't like what you see, click Edit > Undo AutoFormat to get
back to your Pivot Table.
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And that wraps up this short introduction on Pivot Tables. But they are a good way to summarise long lists
of data. In the next section, we take a look at Excel Forms, and see how to download data from a web
page straight into Excel.

Move on to the next section -->

<--Back to the Excel Contents Page
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Data Input Forms

How to Create a Data Input Form in Microsoft Excel

Forms help you input data into a spreadsheet more easily. We'll look at a data input form. We're going to
see how helpful a data input form is, and how easy it is to create one. In fact, you won't be creating one at
all - Excel does all the work for you. First, the problem.

Data Input Forms

Start a new spreadsheet. Enter January in cell A1l. AutoFill the months up to October in column J. Then do
the following:

e Highlight the entire A column by clicking on the letter A at the top of the spreadsheet
e Hold down your left mouse button on the letter A of the column

o Keep it held down and drag to the right

e  Keep dragging until you have highlighted all the columns from A to J

e Your highlighted spreadsheet will look like this:

= January

Al e
N ~ | 8 | c [ o | E | F | 6 [ #u [ 1+ [ J |

January February March  April May June  July  August September October |

e Once you have the columns A to J highlighted, click on Format from the menu bar
e«  From the drop down menu, select Column. A sub menu appears
e  From the sub menu, click on Width

The following little dialogue box pops up:

Column Width EE
Column widkh; |15
(0] 4 I Cancel |

Change your Column width to 15 and then click OK

What should happen is that columns H to J disappear from the screen, and you can no longer see August
to October. Now enter a number for each month. Any number will do.

What happened? You should find yourself having to scroll across the spreadsheet in order to enter
number for the months not on the screen. When you got to October, only the months May to October are
visible. If you want to enter some more numbers, starting with January again, you have to scroll back to the
start.

Clearly this is a problem, if you have lots of data to enter. You don't really want to be scrolling backwards
and forwards. Especially if you had over a hundred rows to fill. It would drive you nuts!

Content downloaded from www.homeandlearn.co.uk



Created By www.ebooktutorials.blogspot.in
There is an easier way - use a Form for the data inputting.

To see how much more simple your life would be, do the following:

¢ Click inside cell A3 of your spreadsheet

e  From the Excel menu bar, click on Data

e  From the drop down list, click Form

e Aform like the one below should pop up on top of your spreadsheet:

Sheetl HE
by [ -| 1o
February: |4 Mew |
e [E ==
April IB Restore |
May: |1|:|
June: |12 .

Find Mext
July: |14 |
August: | 16 Criteria |
September: IIS Close |
Cckober: |2IZI

=

As you can see, the labels for the months are on the left. To the right of each month there is a text box.
The numbers currently in them are the numbers inputted on the spreadsheet.

e  Click the New button at the top

e The text boxes go blank

¢ Click inside the January text box and enter a new number
e  Enter new number for the rest of the months

* When you have finished, click the New button again

Sheetl [ 2]
Januaty: |22 ;I Mew Record
February: |24 Mew
March: |2Eu Delete |
April: I28 Restare |
May: |3III

Find Prey |
June: |32

Find Mext |
July: |34
Augusk: |36 _erterla |
September; |3Ei Close |
Qctober: |4III|

=

When you click the New button, Excel will enter the numbers into your spreadsheet. The text boxes will be
blanked out, ready for some new data.

And that's it. No more scrolling! Easy, hey? The form even gives you button to set up some search criteria
(Find and Criteria buttons). When you want to get back to your spreadsheet, just click the Close button.
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In the next part, we'll take a look at Data Validation Forms.

Move on to Data Validation Forms -->

<-- Back to the Excel Contents Page
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How to Create a Data Validation Form

When inputting data into a spreadsheet, often you will find yourself having to type the same data into cells.
That's where Data Validation comes in handy. Instead of typing the same thing over and over again, you
can turn the cells into drop-down lists. That way, you could just quickly select an item from the list and
move on to the next entry.

For example, suppose you had a column heading called "Student Grade". Even though there are only two
grades available, Pass and More Work Needed, it can become quite laborious having to type either one or
the other. Spelling mistakes will become increasingly more likely the more times you have to enter the
grades. Much better to have a drop down list where you could select the grade. And no more spelling
mistakes!

Data Validation

We'll now construct a spreadsheet with drop-down lists. The one we're going to construct takes us back to
the classroom and our students from previous section.

So start a new spreadsheet, and format it to match the one below:

A B | © | D | E | F
Student Subject Grade Comments

| b= |00 B —

Before we can turn the cells in an entire column into drop down lists, we need some data to go in the lists.
So starting at cell F2, add the following to your spreadsheet:

E | F | & | H |
Comments

Steven Maths A
hdary English B
C
]

Anne Science

Ray History

hark Geography E
Faul Art Fail
Elisa Computers

Kelly French

The data in columns F, G and H will be going into our lists. We can then hide this data so that it's not
messing up our spreadsheet. You'll see how to do this later. But we can now turn Columns A, B and C into
lists.

To turn the cells in an entire Column into a list, do the following:

Highlight the whole of Column A by clicking on the letter A at the top of the column
With the whole of Column A highlighted, click on Data from the Excel menu bar
From the drop down menu, click Validation

The following dialogue box appears:
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Data ¥alidation EE3

| Inpuk Message I Error Alert I

Walidation criteria

Allona;
I.ﬁ.ny wvalue j ¥ Ionore blank

Data:

Ibetween j

™ apply these changes to all ather cells with the same settings

Clear All | O, I Zancel

e Make sure the Settings tab strip is selected

e Click the black down arrow just to the right of “Allow: Any Value”
e Adrop down list appears

e Choose List

e A Source box appears on the dialogue box

The Source is the data that is going into your list. So you need to select the cells with the students in them.
To select the cells with the students in them, do this:

e  Click on the icon to the right of the Source text box:

Source:
| 3[%

™ apply these changes to all ather cells with the same settings

e When you click the icon, the dialogue box contracts

¢ Click inside cell F2 on your spreadsheet

e Hold down your left mouse button, and drag to cell F9

e Then click on the icon again to expand the dialogue box

e The images below show the highlighting and expanded process in action

Click the icon and highlight F2 to F9

E | F | &6 | H |
Comments

ESteven ‘:Maths A
shary ‘English E
D

tAnne !Science
‘Ray ‘History
ihdark \Geography |E
WPaul VAt Fail
\Elisa \Computers
Well ____:French
Data Yalidation EHE

|=$F$2:$F$9 EI
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Click the icon again to expand the dialogue box

Data Yahdation EE

=fF$2:4F49

« If you have done it all correctly, your dialogue box will now look like this one:

Data Yalidation EE

Settings | Inpuk Message I Error Alert I

YWalidation criteria

Allona;

IList j [+ Ignore blank
Data: [+ In-cell dropdown
Ibetween j

Source:

|=¢F$2:4F40 =]

™ apply these changes to all ather cells with the same settings

Clear All | O, I Zancel |

So the Validation criteria should be: "Allow List", and the Source should be = $F$2:$F$9.

Click OK when your dialogue box reads the same as the one above. The cells in you entire A column will
now be drop down lists. Test it out. Click on cell A3, for example. It should look like this:

A | B
Student Subject

I~]

If you click the black down arrow, you should see your list of students. Like the one below:

A | B
Student Subject

Steven I*E

Mary
Anne
Ray
Mark,
Paul
Elisa
kelly

=
=

Click on any student in the list. The student appears in cell A3. Click on another cell in column A and try it
again.

I'm sure you'll agree that it's much better than having to type out a student's name over and over again.

Except we have a slight problem. If you click inside cell Al you'll see that this too has a drop down list.
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Clearly we don't want this to happen for our heading. To turn off the list in cell A1, do the following:

¢ Click inside cell A1

e  From the Excel menu bar, click on Data

e  From the drop down menu, click Validation

e« From the Settings tab strip of the dialogue box, change "Allow List" to "Allow Any Value"

e Click OK

Time for you to try it alone. Change the Subject and Grade columns into drop down list, and then turn off
the list for the headings cells B1 and C1.

The drop down lists for the Subject and Grade columns should look like these when you're done:

A, | B | C

1 Student Subject Grade
2 |Steven Geography  Fail
3 |Paul History C
4 |Mary Science B
5 |Elisa '
6 |kelly
7
g
9
10
11
12 Fronch
13

A | B - Cc |
Student Subject Grade
Steven Geography  Fail
Faul History C
hary SCience B
Eliza English B
Kelly haths |A lv

&
B

H

E
Fail

In the next part, you'll learn how to display error messages. That way, you can control what data your users
are allowed to enter.

Move on to displaying Error Messages -->
<-- Back to the Excel Contents Page
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Displaying Error Messages in Excel

This tutorials follows on from the previous page

In the previous part, you created drop down lists so that you can simply select the data you want, rather
than typing it in all the time. In this part, we'll display error messages if a user types in too much data.

Displaying Error Messages

We can add Validation to the Comments field in our spreadsheet. We'll restrict the amount of text that can
go in the Comments field to a maximum of 25 characters. The comments field you should have is this one:

E | F | 66 | H |
Comments

Steven Maths A
hdary English B
C
]

Anne Science

Ray Histary

hark Geography E
Faul Art Fail
Eliza Computers

Kelly French

So highlight the Comments column and bring up the Data Validation dialogue box again (Click Data >
Validation from the menu). This time, in the Allow drop down box select "Text Length". A few more fields
will appear on the dialogue box:

Data Yalidation EE

Settings | Inpuk Message I Errar Alert I

Walidation criteria

Bl

AT — - | ¥ Ignore blank

Data:

Ibetween j

Minirnurn:
| =
Mazximurn:

| X

I™ apply these changes to all ather cells with the same settings

Clear all | Ok I Cancel |

The Between in the Data text box is exactly what we're looking for. But we need to enter values for the
Minimum and Maximum fields. These are the Minimum and Maximum text lengths that can put in any cell
in the comments column. We'll restrict the length to 25 characters, just so you can see how it works.

e Soclick inside the Minimum text box
. Enter the number 1
e Click inside the Maximum text box
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. Enter the number 25
e Don't click OK just yet

We can add an error message, too, so that we can tell users what they did wrong. To add an error
message, do the following:

e Click on the Error Alert tab strip of the Data Validation dialogue box
e The dialogue box will change to this:

Data Yahdation EE

Settings I Inpuk Message  Error &lert |

v i5how error alert after invalid data is entered:

When user enters invalid data, show this error alert:

Skyle: Title:

ET—

Error message:

(X} ]

|-

Clear All | O, I Zancel |

If your dialogue box doesn't look like the one above, make sure there is a tick in the box at the top "Show
error alert after invalid data is entered."

There are three different Styles you can choose from for your error message. Click the black down arrow
just below Style to see them. Click on each one in turn and see what happens. Then set it back to Stop.

¢ Click inside the Title text box and type "Too many characters”
¢ Click inside the Error message text area and type "The maximum number of characters for this

field is 25 - please try again”
e Your dialogue box will then look like this:

Data Yalidation ElE3

W Show error alert after invalid data is entered

Wehen user enters invalid data, show this error alert:

Skyle: Title:
IStu:up j IT::u:u many characters

Error message:

Q The maximum number of characters for this ;I

figld is 25 — please try again

|-

Clear All | O, I Zancel |

Click OK when you've finished. To test it out, click inside cell E2 and type the following: Steven can do
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a lot better than this. Then press the return key on your keyboard. Your error message should pop up
and look like this one:

Too Many Characters E3

Q The maximum number of charackers For this figld is 25 - please try again

Zancel |

The error alert gives the user the changes to either Cancel the data already input, or to Retry.

The only thing spoiling the look of our spreadsheet are the cells starting at F2, the ones from our list. We
can hide all that data from prying eyes.

Hiding Data in a Spreadsheet

To hide data on a spreadsheet, do the following:

e Highlight the data you want to hide (in our case, highlight F2 to H9)
e  From the Excel menu bar, click on Format

e  From the drop down menu, select Column

e From the sub menu that appears, click Hide

e The three columns with the list data in them will disappear

Now try this. Click anywhere on the D column. Click Format > Column > Unhide. What happens?
Nothing happened, right? So why didn't Excel Unhide your columns?

It's because you did not tell Excel which columns you wanted to Unhide. To do that, highlight columns E
and I. Then click Format > Column > Unhide. Your data should return.

If you don't want anyone else to Unhide your data, you can Protect the worksheet from unwanted changes.
Just click on Tools > Protection > Protect Worksheet. A dialogue box appears. Select your
options, and then click OK.

And that's it for our brief look at Forms. You can do a whole lot more with Forms, but that enough for us.
We can move on to Web Integration.

Move on to Web Integration -->
<-- Back to the Excel Contents Page
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Web Integration and Excel

What you're going to do in this section is to download data from the internet, and put it straight into an
Excel worksheet. We have a page on our website that is set up for you to download straight into a
spreadsheet, and we'll give you the address shortly.

An example of why you would want to download data from a website is this.

You are salesperson out in the field, visiting clients in their homes or offices. You have a laptop that can
connect to the internet. There is a spreadsheet on your laptop. The spreadsheet includes lots of data about
the products you sell. One piece of data is the prices of each item. Your company is rather ferocious on
prices, and it changes them all the time. The question is, how can you, as a salesperson in the field, keep
up to date with the changing prices?

One answer is to use an Excel Web Query. The company will update the prices on the website. You can
then run a Web Query to download the latest changes into your Excel spreadsheet. That way the clients
get the new prices "Hot of the Presses".

We'll see how to run a Web Query soon. But you need a connection to the internet before you can run a
Web Query. In other words, you need to be online. (However, if you know some HTML coding, you can
construct a table in a web page that is on your own computer. Then you point the Web Query to the web
page on your computer, rather than a web page on the internet. Don't worry if you don't know any HTML
coding - it's not necessary for this section.)

But don't go online just yet. Read a few more pages first.
Learn how to Create a Web Query -->
<--Back to the Excel Contents Page

View all our Home Study Computer Courses
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How to Create a Web Query in Microsoft
Excel

You create a web query in Excel when you want to pull data from an internet page and pop it into a
spreadsheet. You can retrieve text from a web page, data in tables, and data that is preformatted on the
web page.

To see how all this works, do the following:

e Open anew Excel spreadsheet

e Connect to the internet, if you're not already

¢ When you are connected, click inside cell A1 of your spreadsheet
e  From the Excel menu bar, click on Data

e  From the drop down menu, select Get External Data

e A sub menu appears

e  From the sub menu, click on New Web Query

e Adialogue box pops up like the one below:

Hew Web Query EHE

1. Enter the address For the Web page that contains the data wou want, IF browsing,
switch back to Excel once vou have located the Web page in wour browser,

I Browse Web, ., |

Z. Choose the part of the Web page that contains the data wou want, Moke that
pre-formatted seckions are treated as tables,

™ The entire page
i+ only the tables
™ ne or more specific tables on the page.

Enter table name(s) or number(s) separated by commas:

3. Choose how much Formatting From the Web page wou want your data to keep:
i+ Mone
= Rich kext Formatting only
& Full HTML Formatting

Save QUEry, ., | Advanced. .. | 2 | Cancel |

There are three sections to the dialogue box. The first section is where you type in the address of the
internet page that you are trying to pop into Excel; the second section is where you specify which part of
the web page you want to insert into your spreadsheet; and the third section sounds a bit technical, but
basically you are choosing the type of formatting to use: do you want to keep the colour scheme, or strip it
bare?

In the first section, you need to type in the name of our internet page. The internet page contains a table
with some product information and some prices. By all means, load it into your browser and have a look at
it. But first, you need the address. So:

e Inthe text box right at the top of the dialogue box, type in this internet address. Make sure you spell it
exactly as it is below:
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http://mvww.homeandlearn.co.uk/ME/webqueryl.htm

e« When you have typed the address in the text box, Select "The entire page" from section 2 of the
dialogue box.

 From section 3 of the dialogue box, select "None"

¢ Click OK when you're done

When you click the OK button, another dialogue pops up. This time your are asked where in your
spreadsheet you want to put the data. You only need to specify the starting cell. The dialogue box looks
like this:

Returning External Data to Microsoft Excel EHE

Where do ywou want ko put the data?
¥ Existing worksheek: |
Zance

——

™ Mew worksheet —lF'r_u:uperties...
" FivokTable report Parameters. .. |

The dialogue box is already set up to put your data into the spreadsheet starting at cell A1. But you could
change that, if you wanted. Cell Al is fine for us, so just click the OK button.

Excel will now look for the internet address you typed. When it finds the web page, it will then take the text
and the contents from the table and put them into your spreadsheet.

If the Web Query seems to be taking too long, you can Refresh it. To do that, click on View > Toolbars
> External Data. A toolbar pops up on your page. Click the Refresh icon, as shown below:

* External Data ]

5i?]

fxme
V:efresh Daka

If everything goes well, you should have a spreadsheet that looks like the following one:

A [ B | C | D | E | F
1 |Code Product In Stock Delivery hax Discount  |Prices
2 %1 Widget One fes 2 Days 20% £10.99
3 |x2 Widget Two fes 2 Days 10% £2599
4 |¥3 Widget Three | Yes 3 Days 5% £49 .95
5 ¥4 Widget Four Mo A, 20% £14.99
B [%5 Widget Five fasg 1 Day 40% £589.94

As you can see, Excel has imported the data from a web page on the internet into a spreadsheet. You now
have a way to get the latest prices from Head Office!

In the next part, we'll import a web page with better formatting.
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Web Query Part Two -->
<-- Back to the Excel Contents Page
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Web Query, Part Two

This lessons follows on from the previous one

The problem with the spreadsheet in the previous section is that it looks a little dull. This second web page
you're going to download into Excel is little more colourful. So do the following:

Click on Sheet 2 of your spreadsheet, and click inside cell Al

Run a Web Query just like you did in the previous section: Data > Get External Data > New
Web Query

This time, when the dialogue box pops up, type in this new address:
http://www.homeandlearn.co.uk/ME/webquery2.htm

In section 2 of the dialogue box, select "The entire page"

In section 3 of the dialogue box, select "Full HTML formatting”

Click the OK button

Click OK in the next dialogue box that asks you where you want to put the data (=$A%$1)
Excel will place the data from the new web page into sheet 2 of your spreadsheet

Although the table itself might look nice and bright, that text heading looks chopped of. Your heading might
look like the following one:

| &8 [ ¢ | o [ E | F [ G

atest Prices

—

o | o | B2

#1 Widget One Yes 2 Days 20% £10.99

The reason it's chopped of is because the cells on row 1 are not formatted properly. If you highlight row 1,
from Al to G1, and then click Format > Cells from the menu bar, you can merge all those cells, and
centre the text (Alignment tab strip, centre, tick box at bottom "Merge Cells".)

The image below shows a tidied up version of the downloaded spreadsheet (you can do all the cell
formatting before you download):
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A B | ¢ | b | E | F | & |

Latest Prices

#1 Widget One Yes 2 Days 20% £10.99
#2 Widget Two Yes 2 Days 10% £2599
#3 Widget Three Yes 3 Days 5% £49.98
#4 Widget Four Mo A, 20% £14.99
#5 Widget Five Yes 1 Day 40% £589.99

And that's all there is to the basics of downloading data from the internet and importing it into an Excel
worksheet.

In the next part, we take a look at adding hyperlinks to your spreadsheets.

Learn how to add a Hyperlink to a spreadsheet -->

<--Back to the Excel Contents Page
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How to add an Hyperlink to an Excel

Spreadsheet

If you have a lot of different worksheets and want a quick way to jump between them, you can use
Hyperlinks. Hyperlinks are those underlined bits of text on the internet that lead to web pages

To get a feel for how they work in Excel, start a new spreadsheet and do the following:

e Click inside cell Al of the spreadsheet

¢ On the Excel menu bar, click on Insert

e  From the drop down menu, click on Hyperlink
e The dialogue box below will appear:

Insert Hyperlink

Text ko display: I

ScreenTip. .. |

Q Type the cell reference;
1
I [

SRS o select & place in this documert:
Ww'eb Page
i =- C,all Reference
Sheetl
E SheetZz
i Sheetd

Place in This
Dacument

Create Mew
Document

=

E-mail Address

(0.4

Zancel |

The icons on the left of the dialogue box are all the places you can link to: Existing file or web page, This

document, New document, or an Email address.

We're going to place links in specific cells of three different worksheets. So:

e Locate the text area under "Or select a place in this document”

e Ifthereis a Plus sign ( +) next to "Cell Reference", click on the plus sign to expand it. You should

see the same choices as in the image above
e Click on "Sheet 3

Now that we have a selected a page to link to, we can specify that Excel goes to a cell of our choice:

e Inthe text box below "Type the cell reference”, type in C10

Our Al cell has nothing in it. So to insert some text for our link, do this:

¢ Click inside the "Text to display" text box
e Typein"Sheet 3"
e Your dialogue box should now look like the one below:
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Inzert Hyperlink EE

Link. b Text to display: IShEEtS ScreenTip. .. |

Type the cell reference;

[ST

Place in This

Docurment

E-mail Address i I Cancel

We can add a screen tip as well.

Click the button in the top right of the dialogue box "Screen Tip". Another dialogue box pops up, like the
one below:

Set Hyperlink ScreenTip EE3
ScreenTip bext:

Mote: Custom ScreenTips are supported in Microsoft
Internet Explarer version 4.0 or later.

(0] 4 I Cancel |

e Click inside the text box and type "Jump to Sheet3 Cell C10" (without the quote marks.)
e Click Ok to return to the main dialogue box

¢ On the main dialogue box, click OK again

e A hyperlink will be inserted into cell A1 of Sheet 1
 Move your mouse pointer over cell Al

e Your spreadsheet will look like the one below:

E | ¢ | D

A
Shest3 {F_nJ

Jump bo Sheet3 Cell 410

O | 77 [ e | D0 | o | —

Click on the link and see what happens. Now it's your turn to try it.

Exercise

In cell C10 of the spreadsheet, insert a Hyperlink to take you to cell B10 of Sheet 2. Add a suitable Screen
Tip.

In cell B10 of sheet 2, insert a Hyperlink to take you to cell Al of Sheet 1. Add a suitable Screen Tip.
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And that ends this somewhat brief introduction to Web integration. There a whole lot more you can do with
Excel and an internet connection: Upload data from a spreadsheet to a web page; Save a spreadsheet as
a web page; Publish a spreadsheet to web page that others can interact with; Hold an Online discussion. In
fact, an entire book could be written on Excel and the Internet!

To wrap up this Excel course, the final section details a few Extra things you can do with Excel. It starts
with something called Object Linking and Embedding.

Move on to Object Linking and Embedding -->

<-- Back to the Excel Contents Page
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How to Insert an Excel Spreadsheet into a
Microsoft Word Document

Spreadsheets are inserted into Word documents using something called Object Linking and Embedding.
Object Linking and Embedding (or OLE), can be a complicated subject, but basically it's used when you
want to insert something from one programme into another programme. The example you're going to see
will embed a spreadsheet chart into Microsoft Word.

You have two choices when you want to embed something from Excel into another programme - to use
linking, or embedding. If you use linking, you can update the data in Excel and see the changes in the
other programme; if you use embedding, any changes you make to Excel will not show up in the other
programme.

First, here's how to create a Linked Object. The two programmes used will be Excel and Word. So if you
have Microsoft Word and Excel, open up both programmes.

In Excel, create the following spreadsheet:

E3 ~| =|=E1*12
A | B | ¢ | D | E | F
Click inside cell E1 and enter a number

Your number multiplied by 12 equals: I EI_l

All the spreadsheet does is multiply whatever is in cell E1 by 12. The answer goes in cell E3. (This
example is not terribly functional: you wouldn't really want to use OLE with this particular spreadsheet. But
it's easy to create, and will serve as an example of how to use Linking.)

e Once you have created your spreadsheet, highlight from Al to E3
e  With your data highlighted, click on Edit form the menu bar

e  From the drop down menu, click on Copy

e  Switch to Microsoft Word

e In Microsoft Word, click on Edit from the menu bar

e  From the drop down menu, click on Paste Special

e Adialogue box pops up in Word like the one below:

Paste Special

Microsoft Excel Worksheet
SheetlIR1C1:R3CS

Source:

Microsoft Excel Worksheet Obiject
Formatted Text (RTF)
Unformatted Text

Picture

Bitrnap

Picture (Enhanced Metafile)
HTML Farrnak

g Paste:
™ Paste link:

esult
v Inserts the contents of the Clipboard into your
Eﬂ document so that wou can edit it using Microsoft Excel

Wiorksheet,
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¢ Inthe main list box, click on Microsoft Excel Worksheet Object
e Of the two Option buttons on the left, Paste and Paste Link, choose Paste Link by clicking on it.
¢  Click the OK button at the top

Word now goes to work and embeds your spreadsheet into the Word processed document. Because we
chose Paste Link, we will be able to view any updates made from Excel. The Word document should
look like the one below:

A

Click inside cell E1 and enter a number

Your number multiplied by 12 equals: 0

To see that it really does update in Word, do this:

e Go back to your Excel spreadsheet

¢ Clickinside cell E1

e Type in the number 7

e Pressthe Return key on your keyboard

e The number 84 should appear in cell E3

e  Switch back to Microsoft Word and view the results
e  The Word document will now look like this

Click inside cell E1 and enter a numhber 7

Your number multiplied by 12 equals: od

As you can see, the numbers from the Excel spreadsheet are now in the Word document. The link worked!

If you don't want Word updating the embedded object, you would select Paste instead of Paste Link
from the Paste Special dialogue box. Everything else is the same.

Things like Charts and Pivot Tables are the ones usually embedded into a Word document, all ready for
the company presentation.

In the next part, we'll see how to reference formulas and data on other worksheets

Learn how to reference formulas and data on other worksheets -->
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Linking to other Excel Worksheets

You can put the answer to a formula on a different worksheet. It doesn't have to go into the same sheet you're
working on. For example, think back to the exam marks spreadsheet we did earlier. We had a spreadsheet that
had the average scores for the students. Below that we had each exam mark as a letter of the alphabet: A, B, C,
etc. The spreadsheet we created was this one below:

B15 j =| =IF(B2>=80,"A" IF(B2>=E0"E" IF{B2=»=45 "C", IF(B2 »=30, "D", "Fail"1)
A | B | ¢ | o | E | F | &6 | H | 1 ]
Steven Mary Anne Raymond Mark Paul Eliza Kelly
Maths 7B a9 43 43 a1 7B a7 56
English 55 ala] 78 B1 47 87 91 73
Science B5 g2 39 53 52 B& 57 45
History 45 91 56 72 49 3] 7a 56
Geography a1 84 54 B4 47 B4 B7 B7
Art 43 B3 49 B2 39 a9 B4 B3
Computer Studies 63 a5 45 o9 41 a2 g3 52
French 35 9 B5 26 28 A1 92 ]

Fal b pd = = = | == = | = | = .
e e e el e e e e e e e E e T L

Overall Average 541 43.0 53.6 56.3 44.3 725 761 58.5
Steven Mary Anne Raymond Mark Paul Eliza Kelly
Maths ] 1 A D C C B A C
English C A B B C A A B
Science B A D C C B C C
History C A C B C C B C
Geography C A C B C B B B
Art ] =] C B D A B B
Computer Studies B A C C ] A A C
French D A B Fail Fail C A C

Instead of putting all those Grades on the same Sheet, we could have put them on Sheet2 of the Workbook.

If you want to put a formula on a different work sheet, you have to set a reference to the Sheet that contains the
numbers going into the formula. An example might clear things up.

e  Start a new spreadsheet

. In cell Al of Sheetl enter the number 4

. In cell A2 of Sheetl enter the number 5

e Click on Sheet2 at the bottom of the spreadsheet
e Clickinside cell Al of Sheet2

e Click inside the formula bar and enter this formula:

=Sheetl!Al + A2

e Press the Return key on your keyboard
e  Excel should give you the answer 4

Four plus five is clearly not four, so what went wrong? Well examine the way we set a reference to the sheet that
held our numbers. It was this:

=Sheetl!Al

When you are setting a reference to a different worksheet, you need the name of the Sheet. Then you type an
exclamation mark (or a bang as it's sometimes known). You then type the cell that you are referring to. So in our
formula, we were saying to Excel "Find the worksheet that has the name Sheetl. Now find Cell Al on the
workbook called Sheet1."

However, the whole formula was this:
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=Sheetl!Al + A2

For the second part of the formula, we have + A2. But we haven't told Excel the name of the Sheet we're
referring to. We've just put A2. If the cell reference in the formula doesn't have the name of a worksheet in front
of it, Excel will assume you mean the current worksheet. Our current worksheet is Sheet2. Cell A2 of Sheet2 is
empty. So the formula adds up the number 4 from cell A1 on Sheetl and the blank cell A2 on Sheet2. Which
gets an answer of 4.

To solve the problem, tell Excel that you want to take the number from cell A2 on Sheetl. So change your
formula to this:

=Sheetl!Al + Sheetl!A2

This time, Excel will give you the correct answer of 9.

The main point to bear in mind when referencing data that is on another worksheet is this: Give Excel the name
of the worksheet followed by a Bang!

In the next part, you'll learn how to Insert Drawing objects into your Spreadsheets.

How to Insert Drawing Objects into your Spreadsheets -->
<-- Back to the Excel Contents Page
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How to Draw a Shape on a Microsoft Excel
Spreadsheet

You can draw on your spreadsheet. You can even put a picture on a spreadsheet. Sometimes a drawing
can help to illustrate the data or function on the spreadsheet. The drawing in the spreadsheet below is
illustrating what the function does:

A | B | ¢ | D E |
1 Calculates the Cosine of Angle B
2
| & |
_4 |Enter a Walue for the Hypotenuse 4
|5 |Enter a Walue for the Adjacent 3
_ B |The Cosine of Angle B = 42
s
_8
=N
10
1] 4
2] 3
13
14
15 B
6

We'll see how to draw and format the triangle shape now. (Don't worry about all that Cosine stuff. But we'll
give you the formula, just in case you want to duplicate the spreadsheet exactly.)

Before you can draw shapes on your spreadsheet, you need to display the Drawing Toolbar. To display the
Drawing Toolbar, do this:

e  From the Excel menu bar, click on View
e  From the drop down menu, select Toolbars
e From the sub menu that appears, click on Drawing

The Drawing Toolbar should appear, but it might be at the bottom. It looks like this:

|44 » [pi]Sheetl { Sheetz £ Sheets / 4]
J Draw - [:3 G,

Click on AutoShapes to see the kind of shapes you can add to Excel. To get the triangle, do this:

e Click on AutoShapes from the Drawing Toolbar
e A menu pops up

 Move your mouse up to Basic Shapes

e A box of shapes appears:
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;‘;\? Lines r

o Connectars L4

Ean: Shapes » Doy <>

% Block Arrows » () O A Iét\]g

Ta Flowchart » OO f;;ght Ttiangle

3 StarsandBanners ¢ () (3 3 [T

%ﬁ Callouts k @ &

ﬁ More Autashapes. .. R @} @:

|P.gtl:15hapes*\ \Dﬁ\'[]{}ﬁ &vi,
14 —]

e Click on Right Triangle, as in the image above

e« Move your mouse on to the spreadsheet. The mouse pointer will now be in the shape of a thin cross
e Hold down your left mouse button

o Keep the left mouse button held down and drag

e Let go of the mouse button when you're happy with the size of your triangle

e You spreadsheet will look something like this one:

The white squares around the shape are the sizing handles. To resize your triangle, move your mouse
over a white square. The pointer will change to the shape of a double-headed arrow. Hold down the left
mouse button and drag. To move the triangle somewhere else, move your mouse pointer somewhere in
the middle of the shape. When your mouse pointer turns into a arrow-headed cross, hold down the left
mouse button and drag the shape somewhere else.

Our triangle is facing the wrong way. To turn it round, do this:

¢  Click on the triangle with the right mouse button

e A menu appears

¢ Click on “Format AutoShape”, but click with the left mouse
button

e Adialogue box appears

e Select the Size tab strip

¢ Click inside the Rotation textbox and change it to 270 degrees

e Click OK

To add some colour to your shape, again Right click on the shape and select Format AutoShape. This
time, select the Colours and Lines tab strip. Click the down arrow of the "Fill Color" box. Choose a colour
for your shape.

To add the letter B to your triangle, you need to add a text box on top of it. So, locate the Text Box tool on
the Drawing Toolbar. Click on it with your left mouse button. Position your mouse at the bottom of your
triangle. Hold down the left mouse button and drag out a text box. Your spreadsheet will look something
like this one:
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Click inside the text box and type the letter B. Now click on one of the edges of the text box, somewhere
near a white square. But click with your Right mouse button. A menu will pop up. When the "Format Text
Box" dialogue box appears, select the Colours and Lines tab strip. Under "Line Color" set it to No Line, as
in the image below:

Format Text Box EHE
Praotection I Properties | Margins | Weh
Faonk I Aligrirment Colors and Lines | Size

Fill

Colar: I|:| - I [ Semitransparent

Ling
Color: -3 Style: Iq
Dashed: | Mo Line [ || ID'?S pt ﬂ
Connector: lm Mo Line
Arrows ————— EEEEEEEN
EEEEEEER

Beginstvie: I D B 0
Begin size: ELULNOEEL g Iﬁ
L E e .
N FEEEE NN N

ER [/ EENN
ok |

Cancel |

Maore Colars, . .

In the "Fill Color" box, set it to No Fill. Then click the OK button. Your final shape will then look like this:

If you want to add the Cosine formula to the spreadsheet, it was this:
=DEGREES(COS(E4 / E5))

Cell E4 will then be the input cell for the Hypotenuse, and cell E5 will be the input cell for the Adjacent.
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In the final part, you'll see how to insert an image into a spreadsheet.

Inserting images into Excel -->
<--Back to the Excel Contents Page
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How to Place an Image onto an Excel
Spreadsheet

Inserting an image into Excel is fairly straightforward. Below is a spreadsheet with a picture in it. The picture serves to
illustrate a lesson on the circumference of a circle.

| | [ | = | ) | Y |

Calculate the Circumference of the Planet

Diameter Radius Circumference |

Planet One 1867 4922 88
Planet Two Laatal 178442
Planet Three 3478 1092646
Planet Four 1367 2589.11

P S o i [ P

—
[iu

The image above was inserted like this:

¢ From the Excel menu bar, click on Insert

e From the drop down menu, select Picture

« From the sub menu that appears, click on From File (Click the Clip Art option if you want to insert a clip art image.)
e The following dialogue box appears:

Insert Picture

Look. in: II:I cartoons j = | @ > ﬁ = Tools -

homerexpressions, gif :I
E millhouse, gif
E’ mrburns. gif
E’ ned.aif
E’ pathetic.jpg
. nlanet, bropd
E’ red_lips_1.qif
(B sad.ipg
E’ seymour, gif
E’ shocked.jpg
E’ simpons. jpg
8 space.jpg
@ tools1.brap
@ tools2.brp
E’ wiggurm. gif

E’ wmo. gif -

File name: I j Insert I
Files of bype: IF\II Pickures {* emf;* wmf;* jpa;* jpea;™®. ifif;*.jpe;*. pna;’ j Cancel |

* Navigate to where on your computer your picture is
e Thenclick Insert

Once the picture is inserted into Excel, you can resize it and move it to a new location. You can even crop it down a bit by
using the Crop tool on the Picture toolbar (View > Toolbars > Picture).
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And that's it for the Excel course! Hope you enjoyed it, and that you're inspired to create even more complex spreadhseets
than the ones you've created with us. Or why not try one of our other courses at the top of the page?

<--Back to the Excel Contents Page
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